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Foreword 
 

The AUA Standards is a document that is in constant need of editing and updating. The rule 
books change, and AUA policies and procedures also change over time. A major revision of the 
Standards is currently ongoing, to include research procedures and to update, correct, and 
organize many things. This will take 6-9 months to accomplish. However, there is a need to 
make some simpler modifications to the AUA Standards effective immediately, for several 
reasons: 

(1) With the arrival of the MBA, the imminent commencement of the MPH, and the 
establishment of the Leadership degree in the School of Postgraduate Studies, we 
recognize that AUA will be a 2-style school—Turabian and APA. The AUA 
Standards needs to expand to include APA Style.  

(2) In order to make the format rules more specific and clear, we are adding pictures 
and clearer format explanations. This should help reduce the amount of editing 
time needed by the AUA editors, and even by students. 

(3) Many students have a lot of questions about how to DO research formatting with 
the computer. A special chapter has been made to address these concerns. 

(4) We want to combine some basic rules between Turabian and APA styles where 
we can, to simplify our lives, and create an “AUA Style.” This will not require 
many changes, but this will make it easier for students and advisors to help each 
other—since as many things as possible will be similar. These changes are being 
introduced here, but they will be phased in—students who have completed their 
work under the old system will not be required to reformat their papers. But if 
they have not yet begun to format their work, they should use these rules. 

(5) We want to simplify some things that we were doing that were difficult, and 
simply not worth the trouble. 

(6) There are some actual errors in the current AUA Standards, and some things that 
need to be updated because we need to move to Turabian 8 (it came out in 2013). 

(7) A restructuring of the content in the current AUA Standards will help to make 
materials easier to locate and understand. 

 
Many of these goals cannot be met quickly. For that reason, this current Supplement 
simply adds the illustrated format pages, a mini- guide for both Turabian and APA 
styles, and the computer tips chapter. Some other chapters with basic writing tips are 
added, as well. The rest will be included in the new edition. For now, this supplement is 
meant to be used IN ADDITION TO the AUA Standards. If there are any discrepancies, 
use the new style if you are a new student, and even if you are an old student, if it is not 
too much trouble to make the changes in your research paper. Either style of headings 
will be accepted for old students, but the order and layout of the preliminary pages must 
already follow these new rules. 
 
If you find any errors or places where the explanations are not yet clear, feel free to 
contact me—this is a work in progress, and your comments can help. 

    
 Shawna Vyhmeister, PhD, Editor 

Director of Research and Extensions 
Adventist University of Africa 
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Chapter 1  
An Introduction to Research Style and Format 

 
Because of its importance in developing thinking skills, research writing is a requirement 

for most graduate courses. It is also typically a part of the culminating phase of graduate work. 
Properly done, the writing in graduate school requires thinking, organizing and evaluating 
information, synthesizing ideas, and original thought from the writer. It also requires a 
knowledge of referencing and formatting techniques that make the work more understandable to 
other researchers. 

Since every institution has its own research traditions and practices, each school has its 
own guidelines that detail how research should be designed, conducted, approved, formatted, and 
edited. This manual documents the research procedures and format rules at AUA, for both the 
Theological Seminary and the School of Postgraduate Studies. It is intended as a guide for any 
written work connected with degree requirements, including term papers, research projects, 
theses, or dissertations.  

 

Style Guidelines vs. AUA Standards 
The difference between style and format is important in order to understand how one 

research standards document can be used for both the Seminary and the School of Postgraduate 
Studies, given the Seminary uses Turabian, and the SPS uses APA style. 

Style Style dictates such matters as whether to use footnotes or in-text references, when 
to write numbers as words or figures; when to capitalize, and whether to prepare a 
bibliography or reference list. When you begin to write, you and your advisor 
and/or committee must agree on the style to be used; that style must be followed 
throughout the document. Because style guidelines are designed for work that will 
be published in a variety of different locations, rules about title pages, placement 
of tables, and other details are inevitably different from the rules for institutional 
papers, where the document is already in its final form. The Turabian and APA 
style manuals are the authority for everything NOT specified in the AUA 
Standards. 

Format AUA requires a certain format for all papers, dissertations, and theses (regardless 
of style chosen), which includes (1) margins and spacing, (2) the institutional title 
page, (3) the order and layout of preliminary pages, (4) placement of page 
numbers, (5) headings and subheadings, and (6) the display of tables and figures. 
The AUA Standards lays out the AUA format requirements and introduces each of 
the two styles used by this institution.  

In matters of format not specified in the AUA Standards, follow the specifications of the 
style guide prescribed by your school: Turabian or APA. 
 

Seminary Kate L. Turabian, A Manual for Writers of Research Papers, Theses, and 
Dissertations, 8th ed., rev. by Wayne C. Booth, Gregory G. Colomb, and Joseph 
M. Williams (Chicago: University of Chicago Press, 2013). 

 

School of  
Postgraduate American Psychological Association, Publication Manual, 6th ed., 
   Studies  Washington, DC: Author, 2010.  
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Chapter 2 
Academic Writing Conventions  

 
 Research has a long and proud heritage, and along the way it has acquired an incredible 
number of conventions as to how one should or should not write. This chapter presents many of 
these general standards for written work that apply to all academic papers. 
 

Organization 
Flow  
 The paper must follow a clear and logical outline. Topics should not recur in multiple 
locations. The arrangement of topics, paragraphs, and sentences must contribute to a clear 
understanding of the study.  

Headings 
 Each section must display unity and coherence, and appropriate transitions should unite the 
sections. Each section, as well as the paper as a whole, must contain appropriate introductory and 
summary statements. A section divided into subheadings must have at least two subheadings. 

Paragraphs 
 A paragraph is the basic unit of organization in a paper, consisting of sentences that 
support the topic (usually the first) sentence. Paragraphs are indented .5” and typically contain 5-
8 sentences, but must have a minimum of 2 sentences.  

Pointers  
 The introductory statement serves as a “road map” to the reader, showing the direction of 
the research in the section introduced; the summary statements close the section, reminding the 
reader of the most important findings. Conclusions are naturally derived from the evidence 
presented. 
 

Writing Style 
Clarity, Directness, and Simplicity of Expression 

  Eliminate jargon and wordiness. Make the paper clearly understandable to the 
reader/evaluator. Be as direct as possible—state specifically what you mean, and do not leave 
ideas half explained. 

Avoidance of Power Words 
 Power words attempt to convince by force, rather than reason. Words like wonderful, evil, 
solution, or exciting push your reader to accept your argument based on passion, rather than 
evidence. Research seeks to understand, not so much to convince. Restraint is appropriate. 

Correct Grammar 
 Correct grammar includes correct grammatical constructions. These include proper verb 
tenses, use of pronouns, and the use of singular and plural. Other aspects of grammar must be 
considered: all items in a list must be parallel in form and, if they have verbs, these must be in 
the same tense; the writer will not use contractions; as much as possible, writers will avoid the 
passive voice. Students whose mother tongue is not English may need to obtain editorial help. 

Inclusive Language 
 Avoid discriminatory language that indicates prejudice against persons on the basis of 
gender, sexual orientation, racial or ethnic group, disability, or age. Statements like the woman 
judge, the black flight attendant, or the chairman are better rendered as the judge, the flight 
attendant, or the chair. Also, do not use he as if it were a neutral pronoun. Alternate genders, or 
use plural. 
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Avoidance of Bias 
 Bias consists of drawing conclusions without proper evidence. It can be manifested in 
many ways in research: by failure to select the sample carefully, failure to seek opposing 
opinions on a topic, privileged treatment of certain sources, or by conclusions not warranted by 
the data. All forms of bias should be minimized in research and writing, or when unavoidable, 
declared openly. 

Linking Words 
 Be careful not to overuse linking words. Therefore, however, for example, might be very 
important to connect some ideas, but the use of these words can be overdone. The sentence may 
actually be more effective without the artificial connector. It is rarely a good idea to begin a 
sentence or a paragraph with terms such as these. 

Format 
 Use correct format according to AUA Standards (see Chapter 5) and the style manual for 
each school. 

Referring to Yourself 
 Do not use the editorial “we.” “We” did not carry out the research, or make any 
conclusions. You may assume, however, that your reader is following along with you (e.g., “We 
now turn to” or “Let us now look at”). Writing in the third person (i.e., using “this writer,” “this 
researcher”) gives the impression that you did not take part in the research, or that you are 
distancing yourself from what you have done. Either use the first person— “I instructed the 
students,” or “my calculations showed . . .”—or recast the sentence to say “students were 
instructed.” Writing “the researcher” or “this researcher” is generally no longer appropriate, 
however, some professors may still prefer this. Check with your advisor, and, in any case, 
minimize references to yourself and keep the emphasis on the research. 

Appropriate Verb Tenses for Research 
1. Active Verbs: Use the active rather than passive voice; e.g., Passive: A study was 

conducted by Johnson (2004). Active: Johnson (2004) conducted a study. 
2. Maintaining Tense: Generally, one should maintain the tense unless there is a good reason 

to change it. Choose a tense and stick with it for at least an entire paragraph. Do not 
alternate between past and present unless there is a specific reason to do so. Exceptions to 
this rule are common, but they are exceptions.  

3. Reporting Results: Research results of a specific study (including yours) are reported in 
the past: “Jones determined that . . .” “Table 5 shows that most people liked oranges.” The 
discussion that interprets data presented, extending the results beyond the sample and 
identifying principles, however, is usually in the present tense. “Jones (1963) found that 
children do not like interacting with hostile parents.”  

4. Reporting Ideas: Ideas are often considered living, or timeless, and therefore are referred 
to in present tense: “Collins suggests that . . .” For that reason present tense is often used 
when discussing ideas, or generally accepted facts in the literature review. This is not 
always the case, however. Sometimes the idea has been replaced by something else, or the 
researcher has at some point changed opinions. If you discuss an idea that is dated, there is 
a need to use past tense (e.g., In 1885 Baker concluded that . . . .). Present, present perfect, 
or past tense are all possible for discussing ideas, depending on situation, and the sense that 
the writer wishes to convey.  

5. Keeping the Historical Perspective: When you are writing, keep in mind your reader who 
will be reading your work in the future. For example, if you write “Today’s educators 
promote,” consider how your statement may be understood in the year 2050. It is better to 
clarify such a statement with “Educators in 2009 promote.” 

 Consider carefully the historical perspective of your subject, especially in the literature 
review. Comparisons, agreements, or disagreements should be thought out very carefully. 
For example, it would be misleading to say that Brown, who died in 1920, disagreed with 
Smith, who wrote in 1965. It would be permissible, however, for Smith, in 1965, to express 
an opinion that disagrees with what Brown wrote in 1915. Also, because of the disparity of 
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the dates, Brown and Smith can hardly concur with one another. It would be possible for 
Smith to concur with Brown’s opinion, however. 

Another historical problem that confuses many non-Adventist readers is the dating of the 
writings of Ellen G. White. There may be a recent publication date which will be used in 
the bibliography or reference list; however, the original date of writing may be important to 
a historical setting or treatment. These original dates and names of publications are 
available through the Ellen G. White Center and can be used beside the version cited 
(White, 1915/1997) or placed in the explanation in the footnote. 
 

Electronic Sources 
 Until recently, electronic sources have been considered less academic or less trustworthy 
than other sources. Today this is less true than before. Yet, not all Internet sources are of equal 
standing. Wikipedia may be a good starting point for information on a topic, but it should 
generally be used with restraint as an academic source.  
 Some peer-reviewed journals exist in print and online. Cite them as you would the print 
edition. Other equally valuable journals are only online. They must be documented as online 
materials. 
 The documentation of online material must be done with the same (or greater) care as that 
of printed material. For information on referencing electronic sources, see the appropriate chapter 
(Turabian or APA) in this document or the appropriate style manual.  
 

Finding Quality Sources 
 When many sources are available, such as on the Internet, it is important for the writer to 
know how to judge which sources are more valuable than others, and how to find and select 
higher quality works. While it is not always easy to separate the wheat from the chaff, here are 
some general guidelines: 

1. Choose more recent over older sources, unless you are doing a historical study of 
early sources. 

2. Choose refereed sources over those which are personally produced. 
3. Prefer primary studies to secondary ones. 
4. Choose recent journals over books (especially textbooks); they are newer, and contain 

primary data. 
5. Choose sources that cite others rather than those without any references or footnotes. 
6. Prefer academic, exploratory writing to hard-sell sources trying to convince you of 

something or sell you something. 
7. Look for data included in text that support the conclusions drawn. 
8. Consider the author’s credentials; choose a professor rather than a student. 
9. Prefer academic sources over popular ones; choose a journal article over Time or 

Newsweek. 
 

Crediting Sources 
Introducing Quotations 
 The space before a quotation is prime territory, and is often wasted or misused by beginning 
writers. Beginning a quote by saying “Hudson says that . . .” does not add any information. The 
quotation marks and the reference already communicate this. Use this space to say something 
important that gives more information. “Comparing students from wealthy communities to those 
from poor neighborhoods, Hudson concludes that. . . .” This gives more information about the 
source—in this case, that the conclusion is based on a comparison of two groups of people. Words 
such as says, comments, mentions, and writes do not really say much about the relationship of the 
quoted material to the ideas you are discussing. When you quote, be sure to add some value to 
what is already there. Be sure that you understand what the writer truly intended. Do not say an 
author argues if he merely suggests. Do not say she emphasizes if the quotation was simply one of 
her many points. Be sure to rightly represent what the author meant. For that reason, suggest is 
often a favored term, as it is more tentative about your interpretation.  
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Discussing Quotations 
Never let another author get in the last word (or the only word) about a topic. You are the 

author. Tell us what you saw in this quotation (rightly representing the author’s meaning or 
intention). Quoting is not an exercise in cutting and pasting. Discuss the quotation, compare and 
contrast it with other sources. At all times make clear to your reader who is speaking. If you do 
not give a reference, it is presumed that you are making the statement. If the idea comes from 
somewhere else, be quick to give credit. Do not quote more than necessary; trim the quote to the 
part that really applies to your study (use ellipsis marks if you leave out information from the 
middle of the quote).  
 
Dealing With Secondary Sources 
 Sometimes, as you read one source, you find that the author quotes another source which 
you find interesting. This is a good way of finding additional material. It is not, however, 
appropriate for you to quote this already-quoted material as though you had read the original 
source. You read only one line or one paragraph of this work—it is not fair for you to judge the 
entire work based on such a small sample. Nor is it fair for you to put this source in your 
reference list, as if you had actually held it in your hands. If you can find the original text and read 
it, you may cite it as a primary source. If you cannot find the primary source, however, you must 
cite it as a secondary source, stating that you found Peterson’s quotation in Gibson’s book that 
you actually read. In this case, your reference will give the author of the quotation, as well as the 
article or book where you found it. Check the Turabian or APA chapter for examples of how to 
cite secondary sources. Make sure to distinguish between what Peterson wrote and what Gibson 
wrote. Doing otherwise is deceptive and is a serious fault in research. Using too many secondary 
sources is also frowned upon. Finding the original sources shows you have done your research 
carefully.  
 
Citing Abstracts  
 If you find an abstract but cannot access the complete article, you must cite it in your 
bibliography or reference list as an abstract, not as if you actually read the article. To do 
otherwise is considered deceptive and unethical. If the entire piece is important to your work, do 
your best to find it. If that is not possible, or the piece is not central, cite the abstract properly, 
showing that you only read the abstract. Using abstracts is good to get acquainted with a field, but 
it does not give you enough depth if you wish to examine the study in your review of literature. 
 

Avoiding Plagiarism 
 Plagiarism is a serious research fault. In many educational institutions, plagiarism is cause 
for giving a failing grade in a class or even expulsion from a program. Plagiarism is an elegant 
name for using someone else’s words or ideas as one’s own. It is equivalent to intellectual 
thievery. For those who espouse a biblical point of view, plagiarism is condemned by the eighth 
commandment: “You shall not steal” (Exod 20:15, English Standard Version).  

 
Adventist University o f Africa  
Statement o n Academic Dishonesty 

As a postgraduate institution, the  Adventist University of Africa (AUA) is committed 
to high quality, original research in multiple areas and disciplines. As a corroboration of this, 
the University encourages primary, cutting-edge research (not searches or compilations) and 
thus manifests zero tolerance for any form of academic dishonesty or plagiarism. Academic 
dishonesty is not only a sign of a flawed academic attitude, but it is also an expression of a 
faulty Christian character. The academically dishonest student is cheating himself, the 
classmates, the professor, the entire academic community, the larger community, and 
ultimately God. A cheating student only proves himself an irresponsible member of the 
academic community and of the larger community. 

Although acknowledging some cultures where copying someone else’s ideas is 
acceptable, AUA embraces the Western definition and attitude toward plagiarism. As such, 
for AUA, plagiarism is any form of copying of ideas and concepts – intentionally or out of 
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carelessness – and presenting them as one’s own, without crediting the author(s) and/or 
proper citing/quoting (e.g., without quotation marks). Plagiarism includes not only copying a 
sentence, paragraph or section word-for-word, but it also implies improper paraphrasing (too 
close to the original) and even borrowing an idea (except general facts and common 
knowledge) from someone else and even from one’s own earlier work without giving proper 
acknowledgement. Plagiarism is not limited only to texts, but also includes media resources, 
laboratory experiments and results, ideas expressed orally, artistic work, and all copyrighted 
works. Even if a work is no longer under the copyright law, the work must be properly 
credited. In addition to the concept of copying improperly and lack of crediting, plagiarism 
also includes unfair use, that is, indiscriminate use of too much material from a source, even 
if properly quoted and credited. 

Plagiarism attracts severe penalties, usually decided by the professor, supervisor, or 
advisor. The penalties may take the form of failure of the paper, or of the entire course, 
suspension and even expulsion from the University. The University also reserves the right to 
revoke the degree of a student whose work has been proven plagiarized or academically 
dishonest. In addition, the writer must remember that plagiarism may also involve court 
processes, especially when involving copyright material. 

While AUA is working on verifying the authenticity of the research work of students, 
including plagiarism-verification technology, the responsibility for plagiarism rests entirely on 
the writer/student. Lack of time and of funds, lost sources, ignorance, unintentional mistakes, 
examples of other cases, carelessness, desire to improve the grade, linguistic difficulties, 
difference of culture, and other possible situations do not constitute an excuse for plagiarizing 
for a work accomplished for AUA. 
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Chapter 3  
The Mechanics of Academic Writing 

 
 Mechanics has to do with all the little rules of writing, such as punctuation, spelling, 
capitalization, fonts, spacing, abbreviations, numbers, and such. The rules in this chapter will be 
especially useful for those writing a thesis or dissertation, but most also apply to research papers 
for coursework. Many specific format rules are revisited in Chapter 5 under AUA Standards. 

 
Spell-Checker and Grammar-Checker 

 Computers provide tools for correcting typing and grammar errors, as well as levels of 
formality. Watch the green lines under words or phrases given by the grammar checker and the 
red lines under words given by the spell checker. Clear these up before you hand in your paper 
(make sure your dictionary is set to either American or British English—both may be accepted, 
but check with your advisor). There are many optional settings for the grammar checker: in 
Microsoft Word, go to Review/Spelling and Grammar/Options. Check the things you want the 
computer to do (check them all if you wish). The grammar checker can be wrong, but it tends to 
be right more often than the language learner, so do not ignore it. 
 

Format 
Page Layout 
 Margins. For theses and dissertations, the left-hand margin must be 1.5 inches. All other 
margins must be one full inch (the page number can be slightly below this—see page numbers, 
below). For term papers, margins are one inch on all sides.  
 Justification. Use a left justified, ragged right margin rather than a justified margin. 
 Font. A proportional, serif font is required for research like Times New Roman. 
Proportional means that a narrow letter like l takes up less space on a line than a wider letter, like 
m. Serif means that the letters have little lines added, like at the base and the top of the N or the 
bottom of the p. While not helpful for projection, these lines make printed text easier to read. 
 Page numbers. All pages are numbered at the bottom center of the page, approximately ¾ 
inch from the bottom edge of the paper. Placement of numbers must be consistent. Pages that 
have landscape material have the page number in the same position and direction as all other 
pages. Pages in the appendix that already carry numbers, such as tests or instruments, are also 
numbered in accordance with the paging of your paper, but this number is placed just inside the 
margin in the bottom right-hand corner, within square brackets.  
 Line spacing. Research text is double spaced, and indented 5 spaces (.5”) at the 
beginning of each paragraph, with no additional space between paragraphs. Numbered lists and 
tables can be single spaced if it improves readability. Further details relating to spacing are found 
in Chapter 5.  
 Block quotations. A block quotation is a direct quote of five or more lines (Turabian) or 
40 or more words (APA). Block quotations are single spaced (Turabian) or double spaced (APA). 
Block quotations are indented one-half inch from the left, the same as the first lines of 
paragraphs. Indent the first line one-half inch further if more than one paragraph. No blank line is 
added before or after (or between paragraphs of) a block quotation. Block quotations do not carry 
quotation marks before and after the quote. If there are materials in double quotation marks in the 
original, put them in single quotation marks to show they were quoted in the original. If the quote 
is in the middle of a paragraph, do not indent the text following the block quotation.  
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Line and Page Breaks 
 Headings. A heading should not reach more than half the way across a page. If it cannot 
be trimmed, the heading should be divided at a logical grammatical point into two or more lines 
of similar proportions. 
 Word division. In general, words at the ends of lines should be divided only when 
absolutely necessary, and then according to syllabication as shown in the dictionary. Turabian (8th 
ed.) has an excellent section on line breaks (20.4).  
 Widows/orphans. The first or last line of a paragraph should not appear alone at the top or 
bottom of a page (widow/orphan). A subheading at the bottom of a page must have at least two 
lines of text below it, otherwise, the subheading should begin at the top of the next page. You 
may allow more than 1 inch at the bottom of a page in order to avoid “widow” and “orphan” 
lines.  

Lists/enumerations 
 Parallel construction. Use parallel grammatical construction for items in a list. 
 Punctuation. In an enumeration within a sentence, use a comma to separate items unless 
items in the list contain commas; in that case, use semicolons. An identifying element (letter or 
number) should always be on the same line as the item. 
 Bullets. Numbers are commonly used for vertical lists, but if you wish to avoid the 
appearance of order in a truly unranked list, using bullet points is acceptable to most professors.  
 Numbering format. To identify enumerated items in separate paragraphs, use arabic 
numbers followed by a period (if enumeration is part of a direct quotation, the original 
identifying element should be used); the numbers should be indented one tab position and run-
over lines aligned with the first word (hanging indentation). The periods after numerals must be 
aligned. To identify enumerated items within a paragraph, use Arabic numerals enclosed in 
parentheses (lowercase letters may be used, but numbering format must be consistent). 
 Spacing. Enumerations in separate paragraphs, just like the body text, are usually double-
spaced, but can be single spaced if this would enhance readability, but aim for consistency. 

 
Referencing 

 
 Every quotation, idea, or information taken from another source must have a reference to 
show its origin. In APA this is done using an in-text reference; Turabian uses footnotes. 
 

Bibliography vs. Reference List 
 

 APA and Turabian have different ways of dealing with the list of sources at the end of 
the research paper. Turabian uses a bibliography, which includes all source materials used during 
a research study, whether cited or not. APA uses a reference list, which includes only works 
cited in the research paper. In either case, it is important that all cited works be included in the 
bibliogra-phic entries at the end of the paper, and Turabian users may add sources used which 
were not cited specifically. For specific instructions on Turabian and APA styles, see Chapters 6 
and 7. 

 
Quoting and Referencing 
 Copy carefully. Direct quotations from another author’s work should be reproduced word 
for word, including internal punctuation of the original source. Enclose quoted material in double 
quotation marks (except in a block quotation). Always check direct quotations against the 
original to ensure that there are no discrepancies. If something is wrong in the original, copy it 
faithfully, and put [sic] after it, to show that you found it like that in the original document. If you 
add emphasis (bold or italics) to the original, add (emphasis mine) after the closing quotes. If it is 
already there, say (emphasis in original) after the closing quotes.  
 Referencing. Every time more than 2-3 words from another source are used in your paper, 
they must be enclosed in quotes and a reference given, including page or paragraph number. If 
the source is from another person’s work and you cannot find the original, cite it as a secondary 
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source. 
 Capitalization. The first letter of the first word of a quotation may be upper or lower case. 
If you weave the quotation into the syntax of your sentence, begin it with a lowercase letter even 
if the original began with a capital letter (no need to mark this change). If the quotation is set off 
syntactically by a comma, period, or colon, and is a complete sentence, begin it with a capital 
letter even if the original is lowercase.  
 Word not in original. Use square brackets to enclose material inserted in a quotation by 
some person other than the original writer, e.g., Jones (2003) reported that “malnutrition is one of 
the [most] prevalent problems in the area” (p. 8). 

 
Mechanics 

Punctuation 
 Period. Use a period at the end of a complete sentence. Use it to separate parts of a 
bibliographic entry, and after all but the most common abbreviations.  
 Comma. Use commas between elements (including before words such as and and or) in a 
series of three or more items. Do not use commas for seriation within a paragraph or sentence if 
there are commas within the items; rather, use semicolons (e.g., The respondents were (a) 
mothers, 20–30 years old; (b) 3rd-grade students; and (c) teachers with 5 years experience). 
 Colon. Use the colon after a clause to introduce a series of items only if the clause is a 
grammatically complete sentence (e.g., The following are ways to treat insomnia: (a) think about 
short-term HRT, (b) consider an alternative, (c) wick away the problem, and (d) chill out). Do not 
use a colon after an introductory phrase that is not a complete sentence, or after a verb to 
introduce a series of items (e.g., The respondents were (a) mothers, (b) 3rd-grade students, and 
(c) teachers with 5 years teaching experience). Also, use a colon in references between place of 
publication and publisher (e.g., Garden City, NY: Doubleday; New York, NY: Free Press). 
 Parentheses. Use parentheses (not square brackets) if you wish to explain something that 
does not fit with the grammar of your sentence. If it is a complex explanation, put it in a footnote. 
Parenthetical material within parentheses is placed in square brackets, but this is not common. 
Do not use parentheses back to back; rather, use a semicolon to separate the statements, and 
enclose them in a single set of parentheses. 
 Hyphen (-). Hyphenate a compound with a participle when it is before the word it 
modifies (e.g., the t-test results, decision-making policies, up-to-date technology, middle-class 
houses, 4th-year students). None of these are hyphenated if they occur after the noun (e.g., the 
results from the  
t test, policies about decision making, the technology was up to date, houses of middle class 
employees, students in the 4th year). Do not use a hyphen if a compound adjective cannot be 
misread or its meaning is established (e.g., grade point average). Self-compounds are always 
hyphenated regardless of whether they are used as an adjective or a noun (e.g., self-explanatory, 
self-study, self-confidence). 
 Dash (—). A dash usually shows an interruption of the flow of thought (e.g., Beethoven’s 
music—unlike that of Mozart—uses emphatic rhymes). If you are typing in Word, the dash will 
appear automatically if you type two hyphens, then continue typing. 
 Ellipsis points. Three dots indicate omitted words in direct quotations within a sentence. 
Leave spaces before and after the dots (. . .). For omitted words between sentences or paragraphs, 
use four dots; the first serves as the period for the first sentence (so it has no space before it). Do 
not use ellipses at the beginning or end of a quote, but when material is removed from the 
middle.  
 Single quotation marks. Use single quotes to enclose text that was enclosed in double 
quotes in someone else’s work. This is a secondary source (you did not read the original quote), 
and should be used sparingly. The source of the material in single quotes should not be put in 
your reference list. In some fields, a specific word may be set off in single quotation marks, but 
this is not common. 
  Double quotation marks. Use double quotation marks to show every place someone 
else’s words are quoted directly, unless it is a block quote, in which case the quotes are not 
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necessary.  

• In the text of a paper, use quotes to set off the title of a study, an article, or a chapter. Use 
italics for book titles. Follow specific style rules for reference list or bibliography. 

• Use quotes to introduce a word or phrase used as an ironic comment (first time only; e.g., 
the “home-schooled” children). 

• Use quotes to mark material from a survey item or verbatim instructions to participants 
(e.g., The item “parents influenced my decision to take up nursing” ranked least among the 
factors.) 

• Do not use double quotes to cite a letter, word, or phrase as a linguistic example, or to 
introduce a key or technical term; instead, italicize them (e.g., the word leverage here is 
used to mean . . .). However, do not italicize the term in subsequent use.  

• Do not use double quotes to show possible disagreement with a statement: do not use any 
punctuation with such expressions (e.g., the teacher rewarded the class; not, the teacher 
“rewarded” the class). 

• Do not use double quotes to identify anchors of a scale; instead, italicize them. Ex.: 
Answers were ranged from 1 (strongly agree) to 5 (strongly disagree). 

• Commas and periods are always placed inside quotation marks; place other punctuation 
marks inside quotation marks only if they are part of the quoted material. 

 
Spacing After Punctuation 
 General spacing. Only one space is used between words, after commas, colons, 
semicolons. There is no space before or after a colon in the expression of ratios.  
 Periods. Current usage puts only one space after a period (full stop). Abbreviations do not 
have any space after internal periods (e.g., p.m., etc., U.S.A.). Only one space is used after 
periods that separate parts of a reference citation. 
 Do not use a period after a statistical or metric symbol.  
 Hyphen. No space is used before or after hyphenated compound words 
 Dash. No space is used before or after a dash.  
 Negative value (-). Use a hyphen with a space before but not after it (e.g., the total is -
2.76).  
 Equals (=). Use a space before and after; e.g., SD = 1.43. 
 
Italics 
 Emphasis/clarity. In general, italics, particularly for emphasis, should be used sparingly. 
Italicize a new, technical, foreign, or key term or label (italicize the first time only); letter, word, 
or phrase used as a linguistic example (italicize the first time only); and words that could be 
misread. 
 Titles. Italicize titles of books, and names and volume numbers of periodicals in reference 
lists or bibliographies. Also italicize titles of books mentioned in body text. 
 Statistical symbols. Italicize all letters used as statistical symbols/abbreviations, whether 
in body text or in tables, or algebraic variables; e.g., a + b = y; (M = 1.45, SD = 2.32); always 
italicize the letter “t” in t test and “p” in p-value. 
 Scales and scores. Italicize test scores and anchors of a scale; e.g., MMPI scales: Hs, Pd; 
answers ranged from 1 (strongly agree) to 5 (strongly disagree).  
 
Bold 
 Bold font is acceptable for certain headings in both APA and Turabian. It is not indicated 
for any further use within the text of a research paper. 

 
Capitalization 
 Capitalize proper nouns (see Appendix F for capitalization rules for religious terms). 
 Titles. Use title case for subheadings (Levels 1 and 2), table titles, subheading entries in 
table of contents, and title entries in list of tables and figures. Use full caps for chapter titles. 
 Title case. Title case means capitalizing all nouns, pronouns, verbs, adjectives, adverbs, 
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and other words of four letters or more, except short prepositions, articles, or conjunctions. In 
titles (but not in the reference list), when a capitalized word has a hyphen, capitalize both words 
(exceptions can be made if it makes good sense); in titles, also capitalize the first word after a 
colon or dash.  
 References to literature. In text, capitalize references to titles of sections within the same 
paper (e.g., see Chapter 3, Table 8, or Research Questions), or references to titles of books, 
periodicals, etc. Do not capitalize nouns that indicate common parts of books followed by 
numbers or letters and nouns that precede a variable; e.g., column 5, page 45 of this thesis; trial n 
or item b. 
 Academic references. Capitalize names of university departments if they refer to a 
specific department within a specific university and academic courses if they refer to a specific 
course; e.g., Department of Public Health, Adventist International Institute of Advanced Studies, 
or Foundations of Curriculum; but do not capitalize generic titles: any department wishing to 
participate, or curriculum and instruction courses. 
 Tests. Capitalize exact, complete titles of tests; e.g., Kolmogorov-Smirnov Test; the words 
test or scale are not capitalized if they refer to subscales of tests; e.g., Minnesota Multiphasic 
Personality Inventory Depression scale. 
 Reference list/bibliography. For APA style, use sentence case in reference lists, i.e., 
capitalize the first word of titles of books and articles, proper nouns, and the first word after a 
colon or dash. For Turabian style, use title case for these same items. In both APA and Turabian, 
titles of periodicals are in title case. 
 Tables/figures. Use sentence case for figure titles and headings or text within tables and 
figures (also for heading levels 3, 4, and 5). Use title case for table titles. 

 
Foreign Language in Text 
 A direct quotation in a modern foreign language is treated differently under different 
circumstances, depending on the complexity of the material. For example, in a class research 
paper at the master’s level, the quotation is translated into English and the original is placed in a 
footnote (in APA style, it may be placed in parentheses). In a dissertation heavily dependent on 
foreign languages (notably French and German), it may be left in its original form, without 
translation. It is understood that scholars reading this complex material understand those 
languages.  
 

 Biblical languages are written in their own alphabets. Other ancient Near Eastern 
languages are transliterated according to agreed-upon schemes (see SBL Handbook of Style for 
details). The method chosen must be consistent throughout the text. For biblical languages, an 
English translation may be provided following the foreign script. Make specific arrangements 
with your advisor. If a word or phrase is repeated many times within a few pages, only its first 
mention needs translation. Biblical language phrases or words in the title of a thesis or 
dissertation must use transliteration. 
 
Numbers 
 Write out small numbers. The general rule is to use figures to express numbers 10 and 
above (APA) or 20 and above (Turabian). Use words to express numbers smaller than these 
(there are exceptions).  
 Figures. Use figures for exact numbers, such as time (8:15), dates (May 14), ages (2-year-
olds), weights or measures (2.5 kilos, 5 cm), mathematical/statistical functions (divided by 6, 5 
times as many), and items in a numbered series (Level 2, Grade 5). Also use numerals in the 
abstract of a paper, in tables, and in parentheses. For decades or other plurals, the correct form 
does not require an apostrophe (1970s). 
 Words. Use words for estimates (about four months ago), common fractions (one fourth), 
and any number that begins a sentence, title, or heading. 

 
Statistics and Metrication 
 Statistics can be presented in text, in tables, and in figures. A general rule is that if you 
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have three or fewer numbers, use a sentence; if you have from 4 to 20 numbers, use a table; and 
if you have more than 20 numbers, consider using a graph or figure rather than a table. 
• Do not give a reference or a formula for statistics in common use 
• In tables, use a capital, italicized N to specify the number of members in a total sample; use 

lowercase, italicized n to specify the number of members in a limited portion of the total 
sample. Do not use the statistical symbol of the term in the text; use the spelled-out form. 

• Use lowercase Greek letters (not italicized) to represent population statistics; use italicized 
Latin to express sample statistics. 

• Use the percent symbol (%) only when preceded by a number (APA) or in tables. For 
Turabian, write out the word unless it is in a table or in parentheses. 

 
Abbreviations/acronyms 
 Acronyms should be used sparingly. Do not switch between an abbreviation and the 
spelled-out form. (For rules regarding the list of abbreviations in a thesis/dissertation, see p. 36.) 
 Introducing an abbreviation. Do not introduce an abbreviation if it will not be used at 
least three times. The first time an abbreviation is used, explain it in the text with the acronym/ 
abbreviation in parentheses, and added to the list of abbreviations at the beginning of the paper. 
An exception to this rule would be biblical books, which should follow the list in Table 2. 
 Plural forms. To form the plural of an abbreviation, add s without an apostrophe (SDs, 
vols.). 
 Latin abbreviations. The abbreviations etc., e.g., i.e., viz., and vs. may be used inside 
parenthetical information or in footnotes, but not in the text. Ibid. is not used at all in APA style, 
but is common in Turabian. Et al. is acceptable for use in parentheses or in text. Note that e.g., 
i.e., and viz. are followed by a comma, and et al. is followed by a period. 
 Restrictions. Never begin a sentence with a lowercase abbreviation, statistical symbol, or 
a number. Never use abbreviations in headings or as entries in a bibliography/reference list. 
 Abbreviations without punctuation. State names, books of the Bible, statistical symbols, 
and academic degrees (MA, PhD) do not require punctuation after them. Titles (Mr., Dr., etc.) do, 
and most other abbreviations do, as well. 

Abbreviating state names. Use the two-letter postal abbreviations (no periods) for U.S. 
state names in reference/bibliography entries (for a complete list of the correct abbreviations, see 
Table 1). If the state name is part of the text, write the whole word. 
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Chapter 4 
Computer Formatting Tips 

 Computer formatting tips are frequently learned during the process of writing a major 
research paper, rather than before, which often leads to extra time needed to complete the work. 
This collection of suggestions by researchers who have gone before is designed to save you time 
and energy, but will not replace a basic knowledge of word processing, or the ability to use the 
help screens when you don’t know what to do. Since most students at AUA use Microsoft Word, 
many specific tips will be given for that software. This chapter was created using Windows—if 
you have a Mac, it is possible some of the explanations will not work (please let us know). Many, 
however, are more generic in nature, and can be used with any word processor. 
 

General Instructions 
Spacing vs. Tabs 
 Many people try to use spaces to format lists, to align information inside tables, or for 
parallel columns. A general rule in electronic documents is to avoid using spaces for aligning 
information at all times. Use tabs. If there is no tab set in the position you desire, it can easily 
be adjusted on the ruler bar, or through the menu system (Tabs are under Paragraph, at the 
bottom). Inside tables, use Shift + Tab to achieve the same result.  
 

 Many researchers also find it wiser to indent paragraphs using a tab (set at .5” or 1.25 cm) 
rather than using the automatic paragraph indent. Automatic indentation can cause problems with 
centered headings (they end up not really centered because of the additional tab). 
 
Page Setup 
 Page layout is easiest when the correct page layout is set up before typing begins. If you are 
using Word, go to Page Layout>Page Setup. Set the paper size to A4, and set the margins at 1.5” 
(3.75 cm) for the left and 1” (2.5 cm) for the other three (the bottom one is often better at .8” (2 
cm) in order to achieve text that comes 1” (2.5 cm) from the bottom of the page). Under Layout, 
set the header and footer to .5” (1.25 cm) Also go to Paragraph and under Line and Page 
Breaks> Spacing Before and after Paragraph, choose 0 pt before and after. Then choose Set as 
Default. 
 
Printers 
 Early in a research project, you may not yet know what printer you will use to print your 
final draft. This needs to be decided nearer the beginning than the end, as different printers deal 
with text differently, and pagination may shift noticeably. Once you have done the fine 
formatting for page breaks, do not change printers unless it is absolutely necessary. 
 
Consistency 
 Human beings are not by nature as consistent as is necessary for computer work. All 
headings need to be used in the same way in every chapter. Spacing, margins, fonts, etc., need to 
be consistent throughout the entire document. Research does not leave room for much creativity 
in the way it is displayed. There is only one font, and generally, only one font size. Spacing 
before and after headings must be exactly the same throughout the document.  
  The easiest way to achieve this kind of consistency involves two steps. 

1. Try to take note of the basic pattern to follow while you are writing the document, and 
follow it as well as you can. Write down the pattern so you can refer to it if you forget. 

2. Once a major section of your document is completed, go over it to check for 
consistency. This involves scanning the electronic document for one specific concern 
at a time. Check heading levels and spacing. Then look for margins and page 
numbering. Check that all indents are the same, and that all numbered lists match. 
Work with Table titles, spacing, and contents.  

These things are difficult to see if you search for all of them at the same time. Take the time to 
check each one before printing and giving your paper to your advisor or the editor. 
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Large Documents 
 Computers have many tools for working with a large document that are worth knowing 
about. Moving about in a document can be greatly facilitated by the following: 
 

Effect Command 
Go to the last page of the document Ctrl + end 
Go to the first page of the document Ctrl + home 
Go to the beginning/end of the line Home/end 
Go to a specific part of the document Ctrl + G  
Find a specific word/phrase in the document Ctrl + F 
Highlight entire document Ctrl + A 

  Find and replace words in a document   Ctrl + H 
 
 
Quick Formatting 
 Keyboard shortcuts tend to be much faster than mouse/menu combinations, so learning 
some of them can save you a lot of time. Commonly used shortcuts for formatting include: 
 

Effect Command 
Center Ctrl + E 
Left/right justify Ctrl + L/R 
Bold/italics/underline Ctrl + B/I/U 
Single/double line spacing Ctrl + 1/Ctrl + 2 
Undo 
Redo 

Ctrl + Z 
Ctrl + Y 

Copy/cut/paste 
New page 

Ctrl + C/X/V 
Ctrl + Enter 

Adjust spacing (table lines, tabs) more 
finely than a whole space at a time 

Alt + mouse button 
on the item to adjust 

 
 
 

Tips for Specific Problem Areas 

Bibliography/Reference List 
 The Bibliography/Reference List uses the same technique as a numbered list. DO NOT use 
spaces or “enter” and then a tab to create the look where the first line sticks out further than the 
rest. Type many entries without formatting them, and then highlight them and format them at 
once (it is faster). Click on Paragraph>Special>Hanging and make sure it is set to .5” (1.25 cm). 
 
Find and Replace 
If you find an error you have made consistently throughout your document, and you wish to find 
each one and fix it, you can use the computer to help you search for all instances of something 
and fix it. On the Home menu, choose Find. On the left of your screen, type what you want the 
computer to search for, and click on the magnifying glass, and it will find it for you. If you wish 
for it to replace one text with another text, rather than Find, choose Replace. This gives you the 
option of saying what you want to find, and what to replace it with. You can to this automatically, 
or manually, where you check each instance to be sure it is correct. This is especially useful for 
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things like quote marks, if you have some that are straight (″) and some that are curly (“). If you 
simply find “ and replace with “ all of them will become the same. 
Footnotes 
 Footnotes may be handled slightly differently by different word processing programs. The 
basic idea at AUA is to allow some variation in format based on program differences, but to 
require the student to be consistent. The length of the separator line and the spacing before/after 
it may vary from individual to individual, but should be consistent throughout your paper. 
 To achieve continuous footnote numbering for each chapter in Word, you have two options: 
(1) Make each chapter a separate document (this will work for a while, but not when you need to 
submit your electronic document to the Library once you have finished); (2) Keep all chapters in 
one document, but insert a section break at the end of each chapter, as explained above. Then 
click References>Footnotes, and choose Restart Each Section under Numbering Format. Make 
sure to start at 1 (under format), at the bottom of the page, and apply the changes to This Section 
(under Apply Changes). 
 Make sure that your footnotes are the same font as the rest of your text, and either 10 or 12 
points. If you made the footnotes the wrong font or the wrong size and need to change them all, 
go to References>Show Notes and highlight ALL the footnotes by typing Ctrl + A. Then go to 
the Home menu and select the font and size you desire, and all the notes will change to that 
selection. 
 
Formatting URLs 
 There are three common ways you will frequently need to format URLs.  

1. If you paste the URL into your document, make sure that it is the SAME FONT as 
the rest of your text. If not, highlight it and change the font. 

2. If the URL needs to break somewhere in the middle, to not leave a large blank space 
on the page, find an appropriate place for the break, BEFORE some punctuation 
mark in the URL. The new line of a divided URL should begin with punctuation. 
Once you have identified the place you wish to divide the URL, put your cursor on 
it, and type Shift + Enter (at the same time). Enter tells the computer to make a new 
line; Shift tells it NOT to make a new paragraph. Do NOT simply put a space in the 
middle of the URL, as this will cause the URL to no longer function if you are trying 
to find the website. 

3. The URLs in your paper should have the hyperlinks removed. The easiest way to do 
this is to place your cursor at the end of the URL and to hit Backspace. Check to be 
sure this does not remove the last letter of the URL—if you have found the right 
place, it will not. It will, however, remove the blue font, and the underline. 

 
Page Breaks 
 If you are finished on one page and wish to begin a new page, DO NOT simply hit 
several Enters until you have pushed the cursor to the new page. This makes for many 
problems later when you are formatting your text, because when you change things on 
one page, it affects the next page. Instead, hit Control + Enter (at the same time). This 
tells the computer to begin a new page. If you need to find this mark to delete it later, 
click on the paragraph icon (¶) and it will be visible. 
 
Page Numbering 
 Most of us have struggled with trying to adjust the page numbers in one part of a document 
without changing all the other page numbers in the document. The reason for this is that Word 
has the underlying philosophy that if you want something changed on page 45, you really meant 
to change it all the way back on page 1; therefore, it changes all the other page numbers 
automatically.  
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 If you need to change page numbering (or insert a landscape page), you must insert a 
Section Break and make sure that footer is not connected to the others before you continue. This 
means that if you have introductory pages with no page numbers, pages with roman numerals, 
then regular page numbers for the body text of your project, you will need 3 sections in order to 
paginate this properly. This will allow you to have several different format styles together in the 
same document. 
 To change pagination types, first, you must insert a Section Break anytime you wish to 
make a formatting change. Insert the section break at the end of the page preceding the page 
where you want to change numbering. Click on Page Layout>Breaks>Section Breaks>Next 
Page. If the new section is different from what follows, also insert a section break AFTER it. If 
you have inserted 2 breaks, you should now have 3 sections. 
 Before actually making the page number format change, however, you need to go to the 
footer (double click on it) and “disconnect” it from other footers, so it will not affect all the rest 
of the document toward the beginning, or forward to the end. To disconnect the footer, double 
click on the page number to enter the footer editing space. You should see a note at the top of the 
footer that says “same as previous.” Since you do NOT want this footer to be the same as the one 
before, click the orange-highlighted button Link to Previous (above, on the ribbon), and you will 
see that on your footer, it no longer says “Same as Previous.” Go to the footer for the next 
section, and also “disconnect” it from the section you wish to modify. Once this is done, any 
changes made to the numbering or page layout in this section will not affect the other sections.  

 Troubleshooting. 
1. When you change the page numbers in one section, it changes them in the next 

section also. Either you have not inserted a section break between the two pages, or 
you have not “disconnected” the footers as described above. 

2. The page has the wrong number. Click on Insert>Page Number>Format Page 
Number. Choose the correct number and tell it to start at that number. 

3. The page number has the wrong font/size. Highlight the page number. From the 
Home menu, select the correct font and size. You will have to do this for each 
section, but doing it once should fix all the page numbers in that section. 

4. The page numbers are too low on the page, or almost touching the bottom line of 
text. Click on Page Layout>Page Setup>Layout and make sure the footer is at .5” 
(1.25 cm). Another possible cause is that there are extra lines accidentally entered 
into the footer. From the Home menu, click on the ¶ button, then double-click on the 
footer space. Examine the footer area for any hard returns (they will appear as ¶) and 
remove them. When you are finished, click again on the¶ button to return your 
screen to the normal view. 

 

 Viewing Section Breaks. If you wish to see what section you are in at all times, right click 
on the bottom gray bar in Word, and choose Section as one of the options. This will now show 
you the section number at all times in the lower left corner of the screen.  
 If you wish to see your section breaks, click on the paragraph icon (¶). You will see the 
section break at the end of the text on the page. It can be deleted if need be.   
 
Numbered Lists 
 To achieve nice-looking numbered lists, it is imperative to use tabs between the numbers 
and the text (not spaces). This means you should type the number and the dot, then insert a tab, 
then type the text. If the tab is not the right length, you can adjust it from the ruler bar (highlight 
the text and drag the tab to where you want it), or you can highlight the text and adjust the tab 
settings under Paragraph. When you have typed your list, highlight the entire section, and click 
on Paragraph> Special>Hanging. Make sure that the distance for the hanging indent is .5” (1.25 
cm), which is the same as your paragraph indentation. Also make sure that the distance between 
the numbers and the text is the same if you have multiple lists in your document. 
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 Numbered lists can be single- or double-spaced, depending on how they look best in your 
text. You can decide. If they are single-spaced, you may want to insert a blank line between 
items. 

  
Troubleshooting.  

1. If you did NOT insert tabs between the numbers and the text, they will not line up 
properly. Go back, remove the spaces, and insert a tab for each number.  

2. If you ever need to adjust the space between the numbers and the text, be sure to 
highlight the entire list so it stays the same. 

 
Tables 
 Formatting tables is tricky, and time-consuming. Consistency here is very important. Note 
other specifics in the prior chapter on how tables should look. The main computer tips are as 
follows: 

1. First, note that tables should span the full width of the page, even if they are small. Do 
not go beyond the margins of the text. If the table is too wide to fit, see point 13 in this 
list.  

2. Remove as many lines as possible—it really does look better. Right click on the table, 
and select Borders and Shading>Borders. Here you can select which lines to keep and 
which to remove. 

3. Tables should have ½ point lines around them, not bigger. 
4. Table content should NOT be double-spaced. Single-space it, then block the ENTIRE 

TABLE and select Paragraph>Spacing>Before and After and set it to 3 points before, 
and 3 after. This will allow a bit of space, but not too much. Be consistent with all tables. 

5. Table content can be as small as 10 points, but if you do this, you should be consistent 
across all tables. The titles remain in 12-point font. 

6. Table text can be centered, left, or right-justified, depending on what looks best. Usually, 
the left column is left-justified, and others are often centered.  

7. If you have decimal places that need to line up, right-justify the numbers, then move the 
entire column over toward the center. Use Paragraph>Indentation>Right and choose 
.1” or .15” or .2” (.15 cm or .37 cm or .5 cm), depending on how far you need it to shift. 
You can type the number you want. 

8. Do not use bold with table content, and note that the content is capitalized only on the 
first letter. 

9. Maintain spacing before and after tables. It should be 2 double spaces, 3 (blank lines). If 
this leaves only 1-2 lines of text, push them to the next page. 

10. If you need to insert spacing inside a table, don’t use spaces. Change the margin, or use 
Control + Tab if you wish to have tabs. 

11. If a table fits on a page, it should NOT be split over 2 pages. Move it so that it is on the 
same page, but always AFTER the table was first mentioned in the text. 

12. If table content does NOT fit on the page, you have two choices: split the table and put 
the rest on a second page, or create a landscape page and put the table sideways.  

13. To create a landscape table, insert a blank page and insert section breaks before and after 
it, so that it is in its own section and the footer shows that it is not linked to the other 
sections (see instructions under page numbering). Then, under Page Layout> 
Orientation, choose Landscape. Format your table here, and when it is printed, turn it 
the same way as the other pages. You may skip the page numbering on this page, but 
remember that it is counted, even if not numbered, and make sure the numbering 
resumes properly on the next page. 
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Table of Contents 
 The table of contents contains the first 3 levels of headings exactly as they appear in your 
paper, and the page numbers on which they are found. There are two basic approaches to creating 
a table of contents: you can type the titles manually, or have the computer do them for you 
automatically. 
 Manual method. You can set up the formatting before or after typing the entries. If you do 
it afterward, be sure to highlight the entire table of contents text before setting the tabs. Use a tab 
with dot leaders to create the line of dots. Set the tab by using Paragraph>Tabs. Clear the other 
tab stops and set one at 5.6” (14 cm) with alignment Left and Leader 2 (the one with dots). Add a 
second tab at 5.9” (15 cm) with alignment Right and No Dot Leader to make the blank space 
before the number. At the end of each table of contents entry, insert a tab, which should create 
the dot leader. Insert a second tab, which should make the space and right align the page 
numbers. Additional tab stops should be added at .3” (.75 cm) and .6” (1.5 cm)—left, no dot 
leader—for indenting the second and third level headings (see below). 
  
Sample Heading 1  ...................................................................................................................  13 
 Second Level  ..................................................................................................................  65 
   Third Level  .............................................................................................................  134 
 
 
 Troubleshooting. If you have typed your table of contents before setting up the tabs, here 
are several suggestions.  

1. Before you set up your tabs, highlight the ENTIRE Table of Contents. This way, the 
tabs will be set for the entire section you typed. Otherwise, you may need to re-enter 
the settings multiple times. 

2. From the Home tab, click on the paragraph icon (¶). This is a toggle on/off, and will 
show you where you have spaces that may need to be erased, and other formatting 
features. You can turn it off again once you have seen what you need to. 

3. Make sure that you remove all spaces, and format with tabs. Spaces will create an 
uneven line anywhere you use them.  

4. Do NOT use the period with spaces between to try to make a dot leader (. . . . . . ). It 
will never be evenly spaced. 

 
 Automatic method. A better way to achieve the needed consistency is to generate the table 
of contents automatically. This takes a bit of time to set up, but if any headings move to a 
different page, you can update the table of contents automatically.  
 To use the automatic method, you first must set up Styles so that the headings are formatted 
properly. These headings, once set, will be used for generating the table of contents. The easiest 
way to do this is to type a Level 1 entry heading correctly (with the correct spacing and 
capitalization, bold, etc.), and then right click on Heading 1 using Home>Styles>Heading 1. 
Choose Update Heading 1 to Match Selection. This means that the computer will take your 
heading as the new “normal” for Heading 1. Do the same with headings for Levels 2 and 3. Once 
these are set correctly, you only need to highlight any new heading, and click on the correct 
style—heading 1, 2, or 3, and it will be formatted correctly, AND marked for the table of 
contents. The automatic table of contents does not yield a dotted line with a small space before 
the numbers, as illustrated above in the manual method. As long as the numbers are properly 
right justified, this space is not required. If you use automatic table of contents generation, you 
do not need a space between the dot leader and the page numbers. 
 Generating the table of contents. When you have marked all your headings (at least 3 
levels), create a blank page where you want your table of contents, and select References>Table 
of Contents>Automatic Table 2. This should give you a complete table of contents, but ONLY IF 
you have marked all the headings properly. If you have missed some, they will be missing in the 
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list. Check carefully.  
 Updating the table of contents. If you need to update the table of contents because you 
changed some things or made some mistakes, simply right-click on the table, and choose Update 
Field. Note that you can choose to update everything (this will destroy any formatting you have 
done), or just the page numbers (this will not destroy your formatting, but it will also not update 
the titles). 
  Troubleshooting. There are MANY things that can and will go wrong with the table of 
contents as you format it. Microsoft Word cannot do everything. Once you have finished 
generating your table of contents, there WILL be things you need to format manually. 
Fortunately, the generated text can be edited just like any other text you typed. Here are some of 
the most common things you will need to do/problems you may experience. 

1. The chapter titles are not formatted properly. Microsoft Word does not do these. You 
will need to enter the word “chapter” and put in the numbers, and delete the extra lines 
Word created. 

2. The spacing is not correct for AUA standards. The spacing required for your table of 
contents will have to be done manually. Check where you need double-space, single 
space, etc. 

3. The indentations for section headings are not right. Word should put in the 3 levels of 
headings with proper indentations for you. If not, you can do it manually. Set tabs at 
appropriate distances (often .3”, .6”, and .9” or .75 cm, 1.5 cm, and 2.25 cm). 

4. I have moved my text around (or edited the titles), but the table of contents has not 
updated itself to match the changes. Solution: Right click on your table of contents, 
and ask it to update. If it is text that needs to be updated, it will destroy your 
formatting, and you will have to re-do it. If it is only numbering, you can just update 
the numbers. 

5. When I update the table of contents, all the formatting changes I made disappear. 
The solution is to update ONLY the page numbers, NOT the entire table of contents. 

6. When I generate the table of contents, there are several headings that don’t belong 
there. This is because those headings were marked with the style of Heading 1, 
Heading 2, etc. Go to that place in your document, highlight the text, and select 
Normal from the list of styles. When you regenerate the table of contents (or update it), 
this text will no longer show. 

7. The title Table of Contents is not according to AUA standards. Just fix it. Type it as 
it should be, making sure to put it at 2” (5 cm) with the correct space (triple space, or 2 
blank lines) after it. Make sure it is in the same font as the rest of your document. 

8. There is formatting I don’t like, but I can’t see what it is actually doing. Click on the 
paragraph icon (¶) on the Home menu, and it will be visible, then you can edit it. 
 

Track Changes 
Track changes is a feature of Microsoft Word that allows another reader to make 

comments on your writing, or even to make changes, but keeps track of all those changes so 
that the original author can see exactly what was changed. It is a handy tool that most of you 
can/should use if your advisor is at a distance and you need to send revisions back and forth via 
e-mail. Later, the original author can accept or reject the advice from the “editor” and can 
introduce new changes of his own, which will show up in a different color from the editor’s 
work. 

Changes such as additions or deletions will be marked automatically if Track Changes is 
turned on, but additional comments can be made as well. These will show up in the margins, or 
in the text itself, and must be deleted by the author once they are no longer needed. Like any 
other document, however, if you do not save the file once you are done making the changes, you 
will lose your work. 
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To turn on Track Changes, go to Review>Track Changes on the menu bar in Word and click 
on it. Click in the same place again, and it will turn off. Under Review, you will see a menu bar 
showing the buttons needed for working with the changes—Accept, Reject, New Comment, etc. 
Note the Previous/Next buttons—these are very useful for finding comments in a large 
document, as they will take you from one comment or change to the next—you do not need to 
search for them page by page. 

Tracking sometimes shows up in the right margin, and sometimes in the text itself. The 
problem with the in-text version (with strikethrough) is that it does not show the true page 
breaks. The version in “balloons” makes the entire page a little smaller (temporarily), but DOES 
NOT CHANGE the format, which means that your actual page breaks will be exactly the same as 
what you see on screen. Unfortunately, the Word default is NOT to put the changes in balloons, 
but in text. To change this, click on Review>Show Markup>Balloons>Show Revisions in 
Balloons. 

Play with the tools to become familiar with them. Notice that you can accept each change 
one by one, or you may read a whole paragraph or two, highlight that section, and accept all the 
changes in that section by clicking on the arrow on the right side of the Accept Change button. 
You may even accept ALL the changes in the entire document, but unless you have blind faith in 
your editor, this option is not recommended. Accepting all changes will NOT remove all the 
comments—those must be removed one by one, as you are finished with them. 

If you have removed all marks but your document still looks pushed to one side, as if there 
were still comments present, choose the Accept all Changes in Document button, and this will 
remove any last mark that might have remained by accident, and the formatting will go back to 
normal.  
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Chapter 5 
AUA Standards 

 The format requirements in the AUA Standards for Written Work take precedence over 
requirements in the APA or Turabian style manual for formatting purposes. This chapter 
summarizes and illustrates the formatting rules for the convenience of the researcher. 

Specifications 
Paper: A4 size (8.27” x 11.69” 21 x 29.7 cm), at least 80 g/m2, with high whiteness/ brightness. 

Font:  A proportional, serif font is required (Times New Roman or similar). Text should be 12 
points. Footnotes may be 10 or 12 points. Data in tables and figures may be as small as 10 points. 
The font size chosen must be used consistently. Table titles and figure captions remain 12 points.  

Alignment: All body text should be left-aligned, not justified. 

Margins: 1.5" (3.75 cm) left, 1.0" (2.5 cm) top, right and bottom margin for all pages. The initial 
page of a chapter or a major section (e.g., Table of Contents, Bibliography) has a 2-inch (5 cm) 
top margin. The page number should be at .5” (1.25 cm) from the bottom of the page (see 
Computer Tips Chapter for details).  

Page Numbering: Numbers are placed at the bottom center, in the same font/size as the text. 

Line Spacing: Generally, the text is double spaced. Titles, tables, and headings have specific 
rules for spacing which need to be followed carefully and consistently—check the appropriate 
sections of this chapter. A generic summary is as follows: 

Single space: reference list/bibliography, footnotes, tables (usually), headings (internal 
spacing), table/figure notes, between table title and table, Turabian block quotes 
Double space: Title page, body text, after headings, between reference/footnote entries, 
between main divisions of table of contents and subsections, lists of tables/figures, APA 
block quotes. 
Triple space: Before major headings (levels 1 and 2) preceded by text, after chapter titles 
Two double spaces: Before/after tables/figures 

 
Organization of Research:  Research contains preliminary pages, body, and references, 
presented in a required order and counted and/or numbered according to specific rules.  

Preliminary pages: Use lower case roman numerals. Every page is counted after the 
abstract, but not all have a number on them. A blank page begins and ends the work.  

1. Abstract (approximately 350 words) 
2. Title page (page i, but the number does not show till table of contents) 
3. Copyright page (optional)  
4. Approval page (AUA will add the signatures once the work is approved)  
5. Dedication page (optional—if you use it, keep it short)  
6. Table of contents (page numbering shows from here through acknowledgements) 
7. List of tables (if 5 or more are used) 
8. List of figures (if 5 or more are used; combine on one page with list of tables if 

possible) 
  9. List of symbols and/or abbreviations (if 5 or more are used at least 3 times each)  
10. Acknowledgements (optional)  

 Body of thesis/dissertation: The body begins with page 1. 
11. Body of thesis/dissertation/project (divided into chapters)  

 References/Bibliography: 
12. Appendix(es) with title(s) for each appendix (numbers not shown on title page) 
13. References/Bibliography 
14. Curriculum Vitae (fits on one page) 
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Sample Pages With Detailed Explanations 
The old adage tells us that a picture is worth a thousand words. This section presents 

sample pages, which are pictures of what your AUA research paper should look like. The chapter 
shows samples of all types of pages required for a thesis or dissertation, with tips on how to 
format them correctly. These pages indicate the AUA required format for projects, theses, or 
dissertations. The format of these pages is also appropriate for other written papers. The 
recommendations are mandatory except where specifically indicated otherwise. Not every study 
necessitates the inclusion of all the sample pages illustrated. For example, studies do not always 
contain tables or figures. However, every preliminary page necessitated by the nature of the study 
must follow the indicated form precisely.  
 The sample pages that follow appear in the same order in which they will be placed in the 
final project or thesis. Detailed explanations are placed on the left-hand pages, with sample pages 
on the right throughout this chapter. Where there are differences, both APA and Turabian 
examples will be given. Explanations marked with grey circles are illustrated on the sample 
pages.  
 
Abstract 
 The project, thesis, or dissertation begins with the abstract, which is a brief, comprehensive 
summary of the contents of the document. The abstract must follow AUA standards and include 
the required information. The abstract contains no page numbers and no references. 
 Abstracts are no longer technically restricted to the traditional 350 words for a dissertation 
and 120 for a thesis, however, it is still a good rule of thumb. An abstract that is dense with 
information, concise, and quickly comprehensible will make your paper easier for others to find 
and cite your work. Include key words in the abstract that will enhance other researchers’ ability 
to find your research in a database. An abstract may or may not have titled sections. 
 
Abstracts for an empirical study include 

Problem  A clear statement of the concerns that motivated the study. 
Purpose  A concise summary of what you hoped to accomplish with this study. 

 Method A clear but brief description of the subjects and pertinent characteristics 
(number, age, gender) and the methods used (data-gathering procedures, 
instruments, etc.) in the study.     

Results  The major findings, including statistical significance levels. 
Conclusions A list of conclusions, implications, recommendations, and applications. 
 

Abstracts for a theoretical or philosophical study include 
Topic A clear statement of what the study is about, in one sentence if possible. 
Purpose  A statement describing the organizing construct and scope of the paper. 
Sources  An indication of the basic literature used and/or personal observations. 
Conclusions A statement of conclusions reached with implications or applications. 

1. The abstract begins 2” (5 cm) from the top of the page, the same as all other chapter or 
major section headings. The abstract pages are neither counted nor numbered. 

2. The title is in capital letters: THESIS ABSTRACT, DISSERTATION ABSTRACT, or 
PROJECT ABSTRACT. Following are details about your degree and your school. 

3. Single space within headings, double space between them. 

4. The title of the research is block indented (hanging indent) and all capital letters. 

5. Use the exact headings and information given here. Include the degree of your advisor 
(verify that you have it correct). The date completed is the defense date. 
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Title Page   

 A title page must appear on all papers. Even class papers require the use of the AUA title 
page. The format is the same for any paper, except for the name of the department and the 
degree. Watch carefully for capitalization rules and follow the AUA format and wording exactly. 

1. The title page is page i, but the number does not appear on the page. All preliminary 
pages after this are counted, but some are not numbered.  

2. The date used on the title page is the month of the thesis defense or project approval. 

3. The title page is generally double spaced, and approximately centered on the page.  

4. The first line should begin 2” (5 cm) from the top of the page, with the title beginning at 
4” (10 cm), the description of the research beginning at 6” (15 cm), and the word by 
beginning at 8” (20 cm). 

5. The title should be as short as possible (10-12 words is ideal) but should clearly state 
what the study is about. If the title is more than two lines long, it should be single 
spaced. 

6. No line of the title should be more than half the width of the page. Line breaks in the title 
should come at logical points, and a general inverted pyramid shape should be attempted.  

7. Follow the wording and the capitalization rules exactly. If you have questions, check 
with your advisor or the AUA Editor. 

 

 
  

 

 

 

   

 

 



 
 

25 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

5 

6 

 

2 

   

3 

4 

1 



 
 

26 

Copyright Page/Creative Commons Licensing 
 Copyright indicates the intellectual ownership of material. While it is not required to 
copyright your AUA project, it is encouraged. Use of copyrighted material is limited to (a) “fair 
use” or (b) licensed use. A simple copyright notice can be done using the sample statement on the 
following page.  
 Creative Commons is a licensing structure similar to copyright that is used extensively for 
academic works. The license is selected and noted by the author at the front of the work, and 
does not require the intervention of any external body. While copyrighting of a thesis or 
dissertation is entirely optional, and your work does have some rights just because your name is 
on the cover, AUA recommends Creative Commons Licensing as way of encouraging academic 
sharing. 
 The licensing scheme is summarized in the table below. AUA recommends Attribution-Non-
Commercial, Share Alike as the default option for theses and dissertations, but students are free 
to select any of these options, in consultation with their advisor. Licenses below the dark line on 
the table do not allow others to use your work commercially.  
 The sample copyright page on the facing page is for the AUA default option. For the text for 
any other license, go to http://creativecommons.org/about/licenses and select “view the license 
deed” for your preferred license. Copy that text and paste it on the copyright page of your 
thesis/dissertation. 
 
License Free to Conditions Implications 
Attribution  
 
(cc by) 

Share 
Remix 
Sell 

Credit must be given as 
specified by licensor 

Free to do anything to or with the 
work as long as credit is given to the 
licensor. 

Attribution 
Share Alike 
 
(cc by-sa) 

Share 
Remix 
Sell 

Credit must be given as 
specified by licensor 
Any derivative work must 
carry the same license 

Free to do anything provided that 
any adaptation of the work carries 
the same license as the original work. 

Attribution 
No Derivatives 
 
(cc by-nd) 

Share 
Sell 

Credit must be given as 
specified by licensor 
No derivative works 

You cannot remix the work; you can 
only use it as it is or sell something 
that includes it, if you give credit to 
the licensor of the work. 

Attribution 
Non-Commercial 
 
(cc by-nc) 

Share 
Remix 

Credit must be given as 
specified by licensor 
Derivative works may not be 
sold 

Free to do anything with the work as 
long as credit is given and it is for 
non-commercial purposes. 

Attribution 
Non-Commercial 
Share Alike 
 
(cc by-nc-sa)  

Share 
Remix 

Credit must be given as 
specified by licensor 
Any derivative works may 
not be sold, and must carry 
the same license 

Free to do anything provided it is for 
noncommercial use and that any 
adaptation of the work carries the 
same license as the original work. 

Attribution 
Non-Commercial 
No Derivatives 
 
 
 (cc by-nc-nd) 

Share Credit must be given as 
specified by licensor 
Work may not be sold, and 
you may not create derivative 
works based on the original 

You cannot remix the work. You may 
use it as it is, but may not adapt a 
survey or table for your use without 
specific additional permission. As 
always, you must give credit to the 
source. You may not sell this work or 
use it for commercial purposes. 

Key 
Share: To copy, distribute and transmit the work 
Remix: To adapt, add to, or restructure the work 
To give credit: Credit must be given as to the source of an idea in the manner specified by the 

licensor, but not in any way to suggest that the licensor endorses you or your use of the work 

http://creativecommons.org/about/licenses
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Approval Page 
 
 The format of the approval page is finalized by AUA at the time when it is signed, but it 
is up to the student to prepare a page that is as correct as possible. 

1. This page is not numbered, but it is counted.  

2. The format is much like the title page, with headings at 2” (5 cm), 4” (10 cm), 6” (15 cm) 
and 7” (17.5 cm). 

3. Follow the wording for the standard parts of this page EXACTLY. 

4. The number of signatures on this page depends on the makeup of the student’s committee 
and the degree sought. 

5. Center the name and position of the committee member under that individual’s signature. 

6. When all committee members have handed in grades for the paper and the editor has 
signed approval, the dean signs the approval page. At this point, the research is considered 
completed, and the document is ready for copying and binding.  

7. The date on the approval page is the date the Dean signs, as opposed to the date on the 
title page, which is the month of the defense or the date of committee approval. 
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Dedication (optional) 
 
 If you make a dedication, keep it brief, and center it on the page. This page has no 
printed number (but it is counted), and does not usually carry a title.  
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Table of Contents 
  
 Any paper longer than 20 pages should have a table of contents. This can be generated 
automatically or manually, but it must be done carefully, as many revisions are frequently 
required in this section. 

1. The table of contents begins with headings of pages that come after the table of contents 
in your manuscript. Earlier pages may have headings of the same level, but they are not 
included in the table of contents list. 

2. While the page count begins with the title page, the actual printed numbers begin with 
the table of contents. All preliminary pages beginning with the table of contents have 
lower case roman numerals, which are printed at the bottom center of each page. (For 
help with how to achieve this in Microsoft Word, see Chapter 4). 

3. The table of contents must reflect the first three levels of subheadings used; it may (but 
does not need to) include the fourth level.  

4. All entries must reconcile accurately (word-for-word, including punctuation) with the 
headings and page numbers in the text. For this reason, the table of contents should be 
the last thing checked before printing. The wording of the subheads in the table of 
contents should contain exactly the same wording as in the text of the paper.  

5. Heading entries are aligned by levels, each level one tab stop (usually .3” or .75 cm) 
indented further than the one before. 

6. Dot leaders are placed between the heading and its corresponding page number. For 
aesthetics and neatness, there is often a blank space (.3” or .75 cm) between the last dot 
leader and the first digit of the page number. If you do not use automatic table of 
contents generation, define a tab stop with dot leaders so they are uniform (see computer 
tips chapter).  Do not enter the dots manually, with spaces between, because they will 
NOT look evenly spaced. 

7. Run-over lines should be indented three spaces (.3” or .75 cm); text should not extend 
beyond the last three dot leaders. 

8. Table of contents entries for chapter headings (and other major sections such as List of 
Tables, Appendices, Bibliography, etc.) are uppercase, flush left, single-spaced and 
indented if there are run-over lines, and separated from subheading entries by a blank 
line. 

9. Subheading entries are title case and single-spaced.  

10. Double space between appendix entries. 
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List of Tables (if required) 

1. When five or more tables appear in your text, include a list of tables.  

2. The title begins 2” (5 cm) from the top of the page, as do all major section titles. 

3. If both the list of tables and the list of figures can fit comfortably on one page, put them 
together; however, each retains its own title. 

4. The titles for lists of tables, figures, and abbreviations are all capital letters, like any 
chapter title, with a triple space after.  

5. The wording of the titles of tables in the list should correspond exactly with that used in 
the tables as they appear in the text.  

6. Titles are title case, just as in the text. Entries are single spaced, with double spacing (or 
at least 1.5) between them.  

7. Table and figure numbers are included in the list of tables and figures. Note that the dots 
after the numbers must line up. 

 
 

 
List of Figures/Illustrations (if required) 
 

8. When five or more figures (or illustrations) are used in your text, a list of figures is 
required.  

 
9. The wording in the list of illustrations should correspond exactly with the legend that 

appears beneath the illustrations in the text.  
 

10. If the legend is expanded to give further explanatory information, the expanded portion 
is not included in the list.  

 
11. As for any other title in the table of contents, if the figure title is too long to fit on one 

line, move it to the next line, allowing for at least 4-5 dots of dot leader. The run-over 
line should be indented 3 spaces (.3” or .75 cm). 

 
12. As in the table of contents, there should be at least 3 characters (.3” or .75 cm) of space 

between the end of the dot leaders and the page numbers, which should end flush with 
the right margin. The white space can be missing, but the numbers MUST be right-
justified. 
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List of Abbreviations (if required) 
 

1. A paper that uses five or more abbreviations at least three times each—especially in 
footnotes as done in the Seminary—must have a list of abbreviations.  

 
2. The title begins at 2” (5 cm) and the list is double spaced between items. 

 
3. When a list of abbreviations is included in the paper, the list is arranged alphabetically 

according to the abbreviation.  
 

4. The abbreviations (usually in capitals) appear in the left-hand column, with the source 
they stand for in the right-hand column. Do not add punctuation or anything additional. 
Use tabs, not spaces, to create the second column. 
 

5. Abbreviations of books or journal titles are in italics. Abbreviations of book series are 
not in italics. 

 
 

 
Acknowledgements (optional) 
 
This is the place to thank those who have helped you and supported you in this research. It is 
appropriate, but not required. If you write an acknowledgements section, try to keep it to a 
maximum of two pages. 

 
6. The title, ACKNOWLEDGEMENTS, begins 2” (5 cm) from the top of the page, with a 

triple space (2 blank lines) after it, as for all similar headings. 
 
7. Acknowledgements should include committee members and family/friends who have 

supported you during your research.  
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Text  
 All pages of the text and all reference materials that follow are numbered with 
consecutive arabic numerals. The text is generally double spaced throughout, except Turabian 
style block quotes, some lists, headings, tables, and figures (see details below). Chapter numbers 
are written in arabic numbers. The text should be organized logically according to the nature of 
the study. Empirical research often has a typical 5-chapter model.  
Introduction Explains the goals of the study and an idea of what follows; titled Chapter 1. 
 

Body of Paper Describes the study, including a review of previous research, and for empirical 
studies, the results and an interpretive discussion. The organization will vary 
with the discipline, but arguments must be logically presented and supported 
with facts.      

Conclusions  At the close, the principal findings are briefly stated. The conclusion contains the 
final discussion of the findings and implications of the study, with 
recommendations for further research. In short papers, the introduction and 
conclusion may not have chapter status. If one is a chapter, the other should be 
also. 

 

Headings 
 

In a manuscript or research paper, headings serve as an outline, showing how the study is 
organized. These subheadings must be formatted properly and used in the correct order. 

1. A chapter title is in all capital letters. It begins at 2” (5 cm) from the top of the page, 
and should have a double space between chapter number and title, and a triple space 
between the title and the text. 

2. If the first section of a chapter serves as an introduction, it need not be labeled as 
such. 

3. Abbreviations are rarely used in titles and headings, and words may not be 
hyphenated at the end of a line. Headings generally have little or no punctuation. 

4. Headings should be concise but descriptive. Generally, a section should have at least 
2-3 paragraphs. Rarely should a heading be followed immediately by another heading 
with no intervening text. There are exceptions, but there can never be three successive 
headings: there must be some text after the title and before the next section. 

5. If a section is divided, it must have at least two subsections. Only one subsection 
under a heading level is unacceptable.  

6. The first two heading levels are written in title case (also called headline style), with 
the major words capitalized. The last three levels (3, 4, and 5) are in sentence style 
(the first word and proper nouns are capitalized), ending with a period. See examples 
on pp. 40-41. 

7. Heading levels 1 through 3 cannot extend beyond one half the width of the line. A 
long heading must be broken into two lines, single spaced, with the first line usually 
longer than the second.  

8. At least two lines of text must appear after the heading at the bottom of a page. 
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Sample Headings 
 Below are samples and explanations for how to create each level of subheading in an 
AUA research paper.  The recommendation is to keep headings to no more than 3 levels, if 
possible. 
 

CHAPTER 1 

INTRODUCTION  

 
 

Experimental Programs in North American 
Seventh-day Adventist Education 

 
 

Experimental Programs in Religion 
 
 

 Student-teacher cooperation. The cooperation that exists 
between the students and . . . 
 
 

 Importance of student input. There really is a need 
to listen to what students have to say . . . 
 
 Students feel responsible. When the students feel ownership 
of their learning, several interesting . . . 

 
Level 0 (Chapter Titles) 
(centered, all capitals) 
 
 
Level 1 
(centered, title case, bold) 
 
Level 2 
(left margin, title case, bold) 
 
Level 3 
(indented, bold, sentence case, 
ending with a period) 
 
Level 4 
(indented, bold, sentence case, 
italics, ending with a period) 
 

Level 5 
(indented, italics, sentence 
case, ending with a period) 

 
 

Heading Spacing 
 Below is a summary of how much space should go before or after each heading. 

 
 Two Double Spaces (Three Blank Lines) 

 Before and after tables and figures 
 

 Triple Space (Two Blank Lines) 
1. After chapter titles or Level 0 section headings (table of contents, reference list, 

etc.) 
2. Before major (Level 1 and Level 2) headings that are preceded by text. 

 
 Double Space (One Blank Line) 

3. Between lines of text in the body of the paper 
4. Between a two-line title on the title page  
5. Between major headings and text or consecutive headings with no intervening text 
6. Between body text and subheads that end with a period 
 

 Single Space (No Blank Line) 
7. Between lines of a title (chapter title, table title, or subhead) when it is more than 

one line long 
8. Between table number and title and actual table  
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Footnotes 
 Turabian style requires reference information and certain types of supplementary 
discussions to be placed in footnotes. APA style does NOT require footnotes at all, and 
recommends that most pertinent discussions be place in text. APA does allow some tangential 
discussions or explanations to be placed in footnotes if such is deemed beneficial. For that 
reason, most of what is in this section is mainly for Turabian users. 
 Different word processors deal slightly differently with footnotes. The student is not 
required to reprogram the computer to meet an arbitrary standard, but consistency is important. 

1. Footnotes may be 10-12-point font, but must be consistent throughout the entire 
document. Footnotes are single spaced, with a blank line between them. 

2. Footnotes are indented the same as a paragraph or a block quotation—usually .5” (1.25 cm). 

3. Footnotes are now numbered consecutively from the beginning to the end of the 
chapter (Turabian 8). A new chapter begins again with footnote number 1. For 
information on how to do this in Microsoft Word, see the Computer Tips chapter. 

4. A footnote must begin on the page it is cited. It should begin and end on the same page 
whenever possible. If there is not room for it on one page, transfer a line or two of text 
to the next page so that the footnote falls on a page with more space. A very long 
footnote may appropriately break over more than one page. 

5. The computer will put a separator line before a footnote. The length of this line is not 
important, but it is usually about 20 spaces. Set the footnote options for “below the 
text” rather than “at the bottom of the page.” 

6. The separator line may or may not have a blank line after it before the first footnote, 
depending on the computer software and settings used. Both ways are acceptable (with 
or without a blank line before the first note), but the document must be consistent from 
beginning to end. 

7. When a footnote is continued from one page to the next, the computer may make this 
separator line the full length of the line. This is perfectly acceptable, as it indicates a 
continued footnote, provided the footnote should continue on the new page.  

8. Footnotes provide very important information about the sources cited. They should 
contain the author’s name, the city and state or country of the publisher, and other 
important details. Work with the information in the Turabian chapter of this book to be 
sure to provide the correct information in EACH footnote.  

9. Take care to note when italics, parentheses, and capital letters should be used. Take 
special care when copying unfamiliar names and places, as MANY unnecessary errors 
are made at this point. 

10. Pay special attention to the spacing after punctuation in footnotes (one space), the 
blank line between footnotes, and the full stop (period) at the end of each footnote. 

11. Ibid. can be used when a source is repeated on the same page. Note the proper usage 
with a period and comma when a page number is needed.  

12. Be sure that every source cited in a footnote is placed in the Bibliography at the end of 
the text. 

13. In Turabian, page numbers are NOT indicated with the word page, or the abbreviation, 
p.  (APA does use the p.) 

14. Bible texts do not need to be placed in a footnote unless the list of texts is long (more 
than 3). Note that if the text is placed in parentheses, it is part of the sentence, and the 
full stop follows the reference. Bible information is not included in the Bibliography. 
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Lists 
 A numbered list in the text alerts readers to the organization of your ideas. In any list, 
items must be parallel, both grammatically and conceptually. If you do not wish to indicate order 
or priority, a bulleted list is an acceptable alternative. A list in a paragraph may be indicated by 
lowercase letters enclosed in parentheses (e.g., (a) with another person, (b) alone). 

1. Spacing. Lists are usually double spaced like the rest of the text, but may be single 
spaced (perhaps with double spacing between items) if it will increase readability. 

2. Capitalization. Items in a vertical list should begin with a capital letter, and if they are 
sentences, end with a period. 

3. Numeration. Arabic numerals should be used, followed by a period. If the list 
includes two-digit numbers, the decimal points should be aligned. 

4. Format. Run-over lines should be indented to the same tab stop (hanging indent) as 
the first line of text.  

 
Tables 

Tables are efficient in presenting a large amount of data in a small space, where exact 
numerical values are shown and data are displayed in columns and rows, which aids comparison. 
Tables are much more common and numerous in empirical research, but can be used in any type 
of study. 

1. Introducing Tables.  Tables must be introduced by number before they appear in the 
text.  

2. Discussing Tables. Do not simply repeat the table information in the text. Use the text to 
highlight important aspects of a table, or discuss possible implications, not merely the 
numeric results.  

3. Appropriate Language Use. Table discussion should happen in simple English, not 
statistical jargon.  

4. Placement of Tables. Place table(s) either at the top or at the bottom of a page, near (but 
not before) the paragraph where the table is first referred to and discussed.  

a. A table should fill the width of the page. If data are limited, extend the table 
lines and use the space in a way that makes it look nice. 

b. If only two or three lines of text fit on a page with a table/between tables, move 
the text to another page.  

c. Do not split a table across two pages unless it is larger than one page. Tables on 
a page with text or another table must be preceded or followed by two double 
spaces.  

5. Formatting Tables. Format rules are listed here. Suggestions as to how to accomplish 
this on your computer are given in the chapter on Computer Tips. 

a. Table titles are placed above the table.  

b. Tables are numbered consecutively in the order they are mentioned in the text 
(e.g., Table 3).  

c. Do not use suffix letters or numbers (e.g., Table 3B or Table 3.1).  

d. The table number is italicized, 12 pt font, flush left, and followed by a full stop 
(period).  

e. The table title follows, in title case, with single spacing between title and table. If 
the table title is long, do not indent the second line. 

f. In the Appendix, tables are numbered using the capital letter of the appendix 
(e.g., Table C1).  
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Tables (cont.) 
 

6. Spacing. Tables may be single or double-spaced, based on readability and good taste. 
Vertical spacing can be adjusted by using format/paragraph/spacing before and after, and 
adding 2 or 3 points above and below each paragraph. Be consistent throughout the 
paper. 

7. Alignment. Table content may be centered or flush left or right, depending on readability 
and good taste.  

a. Decimal points in a column must be aligned.  

b. Run-over lines in word entries may be indented by two spaces.  

c. There should at least be three spaces between the longest word in a column and 
the next column.  

8. Capitalization. Column headings and text entries/table items are sentence case. 

9. Font. The same typeface and font size used for the main body text should also be used 
for tables. However, for tables with a large amount of data, a smaller font size may be 
used (never less than 10 points). In this case, the same font size should be consistently 
used for all tables. Note: Font size for table titles should remain at 12 pts.  

10. Lines. Use horizontal lines (1/2 point, not heavier) to separate table title from the 
headings, the headings from the body of the table, and the body from the table notes; 
generally, all other horizontal lines are removed unless they are necessary for readability. 
Do not use vertical rules in tables. Space above and below horizontal lines should be 
uniform across all tables.  

11. Continued Tables. A table may be continued over two or more pages. However, a table 
that is continued must start at the very top of the page. On the second page, Table X 
(continued) appears as well as the title for the continued table and the table headings, and  
(table continues) appears at the bottom of the first page of the table.  

12. Landscape Tables. Large tables or figures may be placed in landscape orientation. The 
table number and title should be closest to the 1.50” (3.75 cm) left margin (the binding 
side). The page number remains oriented in the same way as all other page numbers on 
pages with portrait (vertical) orientation.  

13. Notes. Table notes begin with the word Note below the table, after a blank line. A smaller 
font size (as small as 9 pts.) may be used, but be consistent. Arrange the notes in the 
following order: general note (refers to the whole table), specific note (refers to part of 
the table), probability note. Tables reproduced from another source must be properly 
referenced in the note, giving credit to the source. 
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Figures 
 Any type of illustration that is not a table is called a figure. A figure may be a chart, graph, 
photograph, drawing, or other depiction. Most guidelines for figures are similar to those for 
tables.  
 

1. Titles. Figures in the main body are numbered (separately from tables) consecutively 
in the order in which they are first mentioned in text. The figure number is written 
below the figure in italics, and flushed left, ending with a period (e.g., Figure 3.); the 
caption is written right after the figure number, not italicized, in title case, just as for a 
table. 

2. Placement of Figures. On a page, place figure(s) either at the top or at the bottom, 
near (but not before) the paragraph where first referred to and discussed. Do not place 
only a few lines of text on a page with a figure; if only a small amount of text fits, 
leave the figure alone on its own page. Two double spaces are used before and after 
figures within the text. 

3. Discussion. As with tables, the text should expand, explore, and highlight the most 
interesting parts of the figure. It should not merely repeat the information included in 
the figure. The figure must be mentioned by number in the text before it appears on the 
page. 

4. Notes. Notes for figures follow the same style as table notes (see above). Figures 
reproduced from another source must be properly referenced in the note, giving credit 
to the source. 

5. Readability. All diagrams, drawings, and figures must be clear, sharp, and large 
enough to be readable. A figure may be reduced (but still readable) to accommodate 
the caption. 

6. Landscape Orientation. The page number for landscape tables/figures should be in 
the same position as other pages in the text (portrait orientation). 

7. Emphasis. If you wish to differentiate one part of a figure from another, do not use 
color. Instead, use different types of lines or fill, as color does not show up in a black 
and white document. 
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Appendixes 
 The appendix contains materials that are not essential to the paper but that are useful to 
the reader, often including questionnaires, correspondence, additional data/analyses, original 
transcriptions, etc.  

1. Appendix Titles. The appendixes follow the text. Individual appendixes are labeled with 
letters (A, B, C). Appendix titles are 2” (5 cm) from the top of the page, like other 
chapter title pages. Examples: 

APPENDIX A         APPENDIX B   APPENDIX C 
 

CORRESPONDENCE    QUESTIONNAIRES         RAW DATA  

2. Cover Sheets. An initial appendix cover sheet is required, which looks similar to the 
cover sheet example on the following page, but simply says APPENDIXES. Individual 
cover sheets are often used to identify and/or group appendix materials. The appendix 
title appears EITHER on a cover sheet before each appendix, OR at the top of the first 
page of the appendix (not both places). Cover sheets are counted, but page numbers do 
NOT appear on them. 

3. Do I Need Cover Sheets? Other than the initial appendix title page, individual appendix 
cover sheets are not necessary unless you have an instrument, letter, or other document 
which doesn’t have room for the appendix title at the top of it. If NONE of your 
appendixes require cover sheets, you may put the appendix labels at the top of the first 
page of every appendix. If ONE appendix needs a cover sheet, however, they all should 
have cover sheets, for uniformity. Whether you have cover sheets or top of the page 
appendix titles, additional items in the appendix to do not need labels.  

4. Appendixes in Table of Contents. Each appendix is listed separately by letter in the 
table of contents (see example p. 14). 

5. Reference to Appendix Material. Like tables and figures, EVERY appendix MUST be 
mentioned at least once in the text, to draw the reader’s attention to its existence. It is 
also good to indicate the purpose of making the material available (e.g., for a more 
complete discussion of this anomaly, see Appendix C).  

6. Appendix Organization. Grouping similar materials into one appendix is recommended 
unless there are very few items. There is no required order, but materials are usually 
organized in the order in which they are mentioned in text. 

7. Page Numbering. If page numbers already appear on the appendix material, and this 
makes it difficult to put regular page numbers on these pages, place your new page 
numbers in the bottom right-hand corner in square brackets. 

8. Spacing/Format. Appendixes are ideally double-spaced and with the same margins as 
the rest of the research document, however, this is not always possible. Flexibility in 
format is required in this section, since the documents are frequently not able to be 
reformatted. It is important, however, to be sure that the text will still be visible after the 
binding/trimming process.  

9. Questionnaire Considerations. Many research studies require student-prepared 
questionnaires. If your paper requires such an instrument, it must appear in the appendix 
as it was presented to the respondents. A description of the instrument, as well as a few 
sample questions or parts of the instrument may also appear in the main body of your 
paper. With this in mind, observe the following: 
a. Each item must be in the same tense, and in parallel grammatical construction. 
b. Spelling, grammar, and punctuation must be corrected before the instrument is used. 
c. Rules governing margins, spacing, etc., of the dissertation proper should be 

followed whenever possible in the preparation of the questionnaire. 
d. If a prepared instrument is used which does not meet the margin/spacing rules, it 

can be included. If need be, it can be photocopied and reduced in size so that it fits 
the necessary margins for binding. 

 

 

 



 
 

51 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 

2 

3 

1 

 



 
 

52 

Reference List/Bibliography 
 Papers using Turabian usually include a bibliography that lists every source cited and 
other works that were consulted, but not cited. Papers in APA include a reference list, which 
includes only those sources cited in the paper. In either case, all sources quoted or mentioned in 
the text must appear in the bibliography/reference list. In most cases, it is preferable for the 
bibliography to appear in one list rather than in several categories. Other scholars will find it 
much simpler to search one list rather than search through several categories to locate items of 
particular interest. Two or more categories may be used if it is considered essential, but only with 
the approval of the advisor. 

1. APA style uses a reference list. Turabian uses a bibliography. Follow exactly the rules 
for the style in which your paper is written. 

2. In either case, the heading begins 2” (5 cm) below the top of the page. 

3. Single space the reference list/bibliography. Double space between entries. Use “hanging 
indent” style of paragraphs (do not use hard returns and tabs to create this format look). 

4. The sample bibliography on the following page contains illustrations of many of the 
Turabian format rules. Reference lists/bibliographies and footnotes have a lot of 
detailed format rules contained in the style manual. The introductory style chapters in 
this book are not intended to replace the APA manual or the Turabian manual, but they 
do have the most common types of sources. Consult the style manual or check online if 
you have questions about how to format a reference. Check with your professor(s) or the 
AUA Editor if you do not find the answer.  

5. The city where a book is published is ALWAYS required in the reference list. Do not try 
to replace this with a state, country, or some other information, and never skip it. If you 
are not sure if a name is a city, a state, or a publisher, check with someone who knows. 

6. Consistency is raised to an art form in the reference list. Check things, then check them 
again. Check one by one to be sure all authors cited in text are actually in your 
reference list. APA style users, check that all authors in the reference list are actually 
cited in text (Turabian allows for materials in the bibliography that were read but not 
cited). 

7. Web sources can be difficult to cite properly, are often missing information, and the rules 
keep shifting in order to keep up with the changes in technology. For internet sources it 
is important to find up-to-date tools to help you cite them properly. Fortunately, the 
internet is also a good source of information on how to format web references. Be sure to 
consult it. Check your online sources near the end of your research, to be sure the URLs 
actually work. Update/change sources as needed. 

8. Break a URL before punctuation. Do not insert a period at the end of a URL, or add a 
hyphen if you break it over two lines—these could make retrieval impossible. URLs in a 
reference list should be in black font and not underlined. 

9. In general, in APA style, URLs no longer require a retrieval date for published material, 
but Turabian does. Check with your research style guide or with one of your professors if 
you have a question about this. 
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Curriculum Vita   

 A brief résumé (one page) in list format of your educational and professional 
accomplishments is required for all dissertations and theses. There is no specific required form 
for the vita. 
 
Blank Pages  

The first and last sheets of your work should be blank. These blank pages are not 
counted. 
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Chapter 6 
An Introduction to Turabian Style 

 Chapter 3 describes the reference system called “Turabian” because it comes from the 
work of Kate Turabian, long-time specialist in documentation at the University of Chicago. This 
system is used widely in theology and biblical studies. The chapter is based to a great extent on 
the work of two ladies: Juanita Bissell and Nancy Vyhmeister.1 
 The Turabian style has two parts: footnotes and bibliography. Footnotes, normally at the 
bottom of the page, but sometimes at the end of a chapter, inform the reader about the source of 
all quoted words or phrases, as well as of ideas that came from someone besides the writer. The 
bibliography tells the reader about the sources used for the writing. The information in both is 
almost identical. 
 After providing for you basic information on footnotes and bibliography, this chapter will 
give you specific instructions for different kinds of sources. 

 
Footnotes 

It is impossible for any manual to give detailed information to cover every type of 
reference. If you do not find what you need here, check with the Turabian 8 manual. If your 
paper requires specialized types of references that are not included in these manuals, work with 
your advisor to establish a format that you can maintain throughout the paper. 
 
Format 
 Take advantage of the automatic footnote function in your word processor. When you 
insert a footnote, the word processor puts in a number in the text and a number in the footnote. 
The automatic settings need to be revised to be sure they include the following: 
 Notes are below the text and not at the bottom of the page. 
 Type size is either 10 or 12 points throughout, and typeface is the same as the text. 
 Footnote number is superscript in text and superscript or normal below. 
 Left alignment (ragged right edge). 
 First line of footnote is indented the same as the paragraph. 
 There is an empty line after the footnote line and between notes.  
 Footnotes are numbered consecutively for each chapter unless specific approval for 
beginning the numbering anew on each page is obtained and recorded.2  
 The automatic footnote function may need some assistance so that the footnote always 
begins on the page where the superscript number appears. Unless a footnote is at least half page 
in length, it should appear in its totality on the page where it is announced. This may require 
using a hard return to force some of the text to the next page.  
 
Specific Content Matters 

1. Even if the author’s full name is used in the text, it should be repeated in full in the first 
footnote to a reference. 

2. Although there is a tendency to shorten the second number in a series, such as 121-27; 
1929-94; AUA feels that writing the numbers in full is safer: 121-127; 1929-1994.  

3. Abbreviations may be used in footnotes for commonly used sources (but never in the 
bibliography). If such sources are abbreviated, a list of abbreviations must appear in the 
preliminary pages of the paper. Counsel with your thesis or dissertation committee 
members and determine their preference on this matter before writing. (See information on 
abbreviations below.) 

                                                 
 

1 Juanita Bissell, A Guide for Research Writing: AIIAS Theological Seminary (Silang, Cavite, 
Philippines: AIIAS Publications, 1996, 2002); Nancy Vyhmeister, Quality Research Papers (Grand Rapids, 
Michigan: Zondervan, 2001, 2007, 2013).  

 
2 For instructions on how to achieve this continuous numbering by chapter in Word (or other 

computer programs), see the computer formatting tips in Chapter 4. 
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4. When Bible references are used, the primary version used must be stated in a footnote 
accompanying the first reference. Other versions (apart from the main one used) should be 
indicated immediately following the reference, usually in parentheses (Luke 4:1, RSV; 
Mark 1:10, Moffat). Bible versions do not need to be placed in the Bibliography. If the 
reference contains more than three Bible texts, put them in a footnote. A long list of Bible 
references in the text is not acceptable.  

5.    The names of the books of the Bible must be written out in full in the text. They may be 
abbreviated when between parentheses in the text or in a footnote. Use the acceptable 
abbreviation forms found in Appendix C 

6. References to E. G. White books should follow the same guidelines as other works. The 
familiar SDA abbreviations are not appropriate for research. 

 
Guidelines for Preparing Footnotes 
 The first note to a reference includes author (or editor), title (full title, including subtitle), 
publication facts (city, publisher, and year), and the page(s) from which the material was taken. 
The author’s full name should appear in the first note, unless the author does not use a full name; 
then the initials used are sufficient. Follow the entry in the library catalog. 

The full title of the book, including subtitle, should be used in the first entry, with first and 
last and all important words capitalized (title style). A colon separates title and subtitle, whether 
or not a colon is found in the original work. Titles of unpublished materials or parts of published 
works are enclosed in quotation marks, not italicized.  

Series titles are neither italicized nor enclosed in quotation marks. An initial “The” is 
ignored in series titles, and the editor of a series is not included. Subtitles are generally omitted 
from series titles. The number of a book within a series is given after the title of the series, either 
directly or following a comma. Whichever style is chosen must be used consistently. 
 If the city of publication is very well known (Paris, Nairobi, New York), there is no need 
for a state or a country. Otherwise, complete identification is needed: Loma Linda, CA; Baraton, 
Kenya; Somerset West, South Africa). If you have a list of the abbreviations of the states in the 
US, you may use these. If you do not have such a list, simply use the full name of the state. In 
any case, you must only use one style in the entire paper.  
 For the publisher, abbreviations such as ltd. or inc. are always omitted; the words 
publishers or press are usually omitted—except in the case of InterVarsity Press or Moody Press 
(you would not want to confuse these with intervarsity football or the Moody Institute!).   
 The basic format for a book is the following:  
 
 1F. C. Gilbert, Divine Predictions of Mrs. Ellen G. White Fulfilled (South Lancaster, MA: 
Good Tidings, 1922), 6. 
 
 Subsequent references to the same work take various forms.  
 2Ibid., 19. (Only used immediately after a full note in which only one work is referenced.) 
 3Gilbert, 20. (Short form used in subsequent references if there is only one work by Gilbert.)  
 4Gilbert, Divine Predictions, 16. (The longer form is mandatory if there are two works by 
Gilbert but recommended by AUA for all subsequent references because it avoids confusion. The 
title appears in shortened form, selecting the key words from the title. The same shortened title is 
then used consistently throughout the paper.) 

The abbreviations given in the left column are the following: 
 

F = First footnote entry 
S = Subsequent footnote entry, same author and work (It is assumed that one or more intervening 

footnotes by other authors separate it from the first entry.) 
N = New footnote entry (for the same work but different author or for the same author but different 

work) 
L = A later footnote entry subsequent to a new entry, referring to the original entry 
B = Bibliography entry 
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The following sample shows footnotes from articles in one book by three authors, in 
sequence. The repetition of the source (ISBE) in the first example below is a courtesy to the 
reader. Note that the parentheses surrounding the italicized abbreviation of the book are not 
italicized.  

F  1G. W. Barker, “Mystery,” The International Standard Bible Encyclopedia (ISBE), (1979-
1988), 3:452. 

S  2Ibid. 

N  3Gerhard F. Hasel, “Dragon,” ISBE, 1:990. 

L  4Barker, “Mystery,” ISBE, 3:451. 

S  5Hasel, “Dragon,” ISBE, 1:991. 

N  6W. J. Moulder, “Sadducees,” ISBE, 4:278. 

L  7Hasel, “Dragon,” ISBE, 1:990. 

S  8Moulder, “Sadducees,” ISBE, 4:279. 
 
 When two or more authors with the same surname are cited, succeeding entries for both 
authors must include an initial to distinguish between authors. 
 1E. G. White   2R. White   3J. White 

 Idem, representing the same author within one footnote, is no longer used. Repeat the 
author’s surname. The only Latin abbreviation still used is ibid., when a note references exactly 
the same item as appeared in the previous note, which contained only one item referenced.  

Acronyms or abbreviations for titles used more than twice may be used in footnotes after 
the first complete entry, if the abbreviation appears in the first, full footnote. The title appears as 
follows: New International Dictionary of New Testament Theology (NIDNTT). Acronyms and 
abbreviations are acceptable for series, but they are not italicized: ICC.  Abbreviations of titles of 
whole works subsequently replace all facts of editing, translation, and publication. 
 If a source that can be abbreviated is used three or more times, an abbreviation for it 
should be included in a list of abbreviations at the beginning of the paper. The abbreviation is 
introduced the first time, then used throughout the paper. 

When signed articles from reference books (such as commentaries or encyclopedias) or 
monograph collections are used, the author’s name always precedes the title of the article. Each 
time a new article from the same work is introduced, a footnote must introduce a full new entry 
for the separately authored articles.  

A content note (an explanation or amplification of textual matter) may be followed by its 
source in one of two ways: (1) The reference may follow the content note in parentheses, with 
the publication information in square brackets. (2) The content note ends with a full stop and is 
followed by normal footnote style. See the following examples: 

1Gugliotto discusses at length the accuracy of the King James Version of the New 
Testament (Lee Gugliotto, Handbook for Bible Study [Hagerstown, Maryland: Review and 
Herald, 1995], 313-346). 

2Gugliotto discusses at length the accuracy of the King James Version of the New 
Testament. Lee Gugliotto, Handbook for Bible Study (Hagerstown, Maryland: Review and 
Herald, 1995), 313-346. 

While both methods are acceptable, only one may be used in any one paper. 
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Guidelines for Bibliography Entries 
Bibliography entries appear in hanging indention format. Run-over lines are indented the 

same as the paragraph. 
Entries are single-spaced, with double-spacing between the entries. 
With few exceptions, a full stop follows each major element in the bibliographical entry: 

author, title, edition, editor, translator, series, publication facts, and (when cited for parts of 
works) volume and pages.  

All titles of books and journals are italicized to agree with the style of the footnotes.  
If two or more books or articles are used from one author, for all entries after the first one, 

an eight-space line (underscore) is used in place of the author’s name. This “abbreviation” does 
not hold if the author is editor or coauthor of one book and author of another. Do not use the 
eight-space underscore for the first item on a page; repeat the author’s full name. 

The bibliography is alphabetized by the author’s surname, or in the absence of an author, 
by the title, disregarding any initial article. The author may be corporative: General Conference 
of Seventh-day Adventists. 

Normally entries should appear in one alphabetical list. Separate bibliographies into 
categories only by special permission. 

Do not split a bibliography entry between two pages. If there is not room at the bottom of a 
page to complete an entry, the entire entry should be moved to the following page. 

There must be a bibliography entry for every source used in the text. If several articles, all 
written by different authors, are given from one reference work or monograph collection, a 
separate bibliography entry must be made for each article from that work.  

Foerster, W. “Axios.” Theological Dictionary of the New Testament. Edited by Gerhard Kittel and 
Gerhard Friedrich. Translated by Geoffrey W. Bromiley. Grand Rapids: Eerdmans, 1964-
1976. 1:379-390. 

Schmitz, Otto. “Thronos.” Theological Dictionary of the New Testament. Edited by Gerhard Kittel 
and Gerhard Friedrich. Translated by Geoffrey W. Bromiley. Grand Rapids: Eerdmans, 
1964-1976. 3:160-167. 

For reference works with unsigned articles, a general bibliographical entry is adequate. 

 
Harmony Between Footnotes and Bibliography 

 It is imperative to credible research that footnote entries and bibliography entries agree 
entirely. Information that does not match casts a question mark upon an otherwise fruitful study. 
Indention, format, and punctuation vary between notes and bibliography, but basic content and 
information must be essentially the same, except in publication information for some dictionaries 
and lexicons, which is more complete in the bibliography, and except for page numbers, which 
are omitted in the bibliography. There is no suitable substitute for harmony and consistency. 

 
Sample Entries for Footnotes and Bibliography 

While not exhaustive, these sample entries illustrate the principal difficulties of the 
Turabian footnotes and bibliography entries. The emphasis is on various types of theological 
works. Many of the samples are followed by a list of reference books that should be referenced 
by using that particular format. For additional examples, see Nancy Vyhmeister’s Quality 
Research Papers. 
 

Books 
  
One Author 
F  3A. M. Allchin, The Kingdom of Love and Knowledge (London: Darton, Longman & Todd, 

1979), 46. 
 

B Allchin, A. M. The Kingdom of Love and Knowledge. London: Darton, Longman & Todd, 1979. 
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Two Authors 
F  4John H. Hayes and Stuart A. Irvine, Isaiah the Eighth-Century Prophet: His Times and 

Preaching (Nashville: Abingdon, 1987), 53.  
 

S  5Hayes and Irvine, Isaiah, 54. 
 
B Hayes, John H., and Stuart A. Irvine. Isaiah the Eighth-Century Prophet: His Times and 

Preaching. Nashville: Abingdon, 1987. 
 
Three Authors 

F  6W. Gunther Plaut, Bernard J. Bamberger, and William W. Hallo, The Torah: A Modern 
Commentary (New York: Union of American Hebrew Congregations, 1981), 32. 
 

S  7Plaut, Bamberger, and Hallo, Torah, 33. 
 
B Plaut, W. Gunther, Bernard J. Bamberger, and William W. Hallo. The Torah: A Modern 

Commentary. New York: Union of American Hebrew Congregations, 1981.  
 

More Than Three Authors 
F  8Roland K. Harrison et al., Biblical Criticism: Historical, Literary and Textual (Grand 

Rapids: Zondervan, 1978), 78. 
 

B Harrison, Roland K., Bruce K. Waltke, Donald Guthrie, and Gordon D. Fee. Biblical Criticism: 
Historical, Literary and Textual. Grand Rapids: Zondervan, 1978. 

Editor or Compiler as Author 
F  9R. Pierce Beaver, ed., The World’s Religions (Grand Rapids: Eerdmans, 1982), 35. 

 
B Beaver, R. Pierce, ed. The World’s Religions. Grand Rapids: Eerdmans, 1982.  

 
Edition Other Than the First 

F  10John C. Hodges and Mary E. Whitten, Harbrace College Handbook, 10th ed. (San Diego: 
Harcourt Brace Jovanovich, 1986), 299. 
 

B Hodges, John C., and Mary E. Whitten. Harbrace College Handbook. 10th ed. San Diego: 
Harcourt Brace Jovanovich, 1986. 

 
You may choose to type 10th rather than 10th, but you must be consistent throughout the paper. 
 
In a Series 

F  11Verner W. Clapp, The Future of the Research Library, Phineas W. Windsor Series in 
Librarianship 8 (Urbana: University of Illinois Press, 1964), 92. 
 

B Clapp, Verner W. The Future of the Research Library. Phineas W. Windsor Series in 
Librarianship 8. Urbana: University of Illinois Press, 1964. 

 
The simplified form is given above. You could also write: Phineas W. Windsor Series in 

Librarianship, no. 8; however, you cannot mix the two styles. 
 

Chapter in an Edited Book 
F  12E. Earle Ellis, “How the New Testament Uses the Old,” in New Testament Interpretation, 

ed. I. Howard Marshall (Grand Rapids: Eerdmans, 1977), 203. 
 

B Ellis, E. Earle. “How the New Testament Uses the Old.” In New Testament Interpretation, ed.  
I. Howard Marshall, 199-219. Grand Rapids: Eerdmans, 1977. 

 
Notice the location of the pages in the bibliographical entry! 
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Specific Chapter in a Book 

F  13Hans Conzelmann, “Paul before the Apostolic Council,” in History of Primitive 
Christianity, trans. John E. Steely (Nashville: Abingdon, 1973), 80. 
 

B Conzelmann, Hans. “Paul before the Apostolic Council.” In History of Primitive Christianity, 78-
90. Translated by John E. Steely. Nashville: Abingdon, 1973. 

 
Reprint Edition 

F 14Peter Ward Fay, The Opium War, 1840-1842 (1975; repr., Chapel Hill: University of 
        North Carolina Press, 1997), 67-68. 
 
B     Fay, Peter Ward. The Opium War, 1840-1842. 1975. Reprint. Chapel Hill: University of 
         North Carolina Press, 1997. 

 
Secondary Source 
 The primary source should be used if possible. Use this entry only if the primary source is 
not available.  
 

F  15Phillip J. Currie and Eva B. Coppelus, 101 Questions about Dinosaurs (Mineola, New 
York: Dover, 1996), 36, quoted in David C. Read, Dinosaurs: An Adventist View (Keene, Texas: 
Clarion Books, 2009), 494-495. 

 
S  16Currie and Coppelus, in Read, Dinosaurs, 494. 
 
B Currie, Phillip J., and Eva B. Coppelus. 101 Questions about Dinosaurs. Mineola, New York: 

Dover, 1996, 36. Quoted in David C. Read, Dinosaurs: An Adventist View. Keene, Texas: 
Clarion Books, 2009. 

 
Multivolume Works 

 
One Author and One Title 

F  17Paul Tillich, Systematic Theology (Chicago: University of Chicago Press, 1951-1963), 
2:135. 
 

B Tillich, Paul. Systematic Theology. 3 vols. Chicago: University of Chicago Press, 1951-1963. 
 

F  18Ellen G. White, Testimonies for the Church (Mountain View, CA: Pacific Press, 1948), 
4:35. 
 

S  19White, Testimonies, 3:83. 
 

B White, Ellen G. Testimonies for the Church. 9 vols. Mountain View, CA: Pacific Press, 1948. 
 

F  20G. Campbell Morgan, The Westminster Pulpit: The Preaching of G. Campbell Morgan 
(Los Angeles: Fleming H. Revell, 1955), 5:68. 
 

S  21Morgan, Westminster Pulpit, 7:74. 
 

B Morgan, G. Campbell. The Westminster Pulpit: The Preaching of G. Campbell Morgan. 10 vols. 
Los Angeles: Fleming H. Revell, 1955. 

 
Note: If only one volume is referenced, even if in repeated notes, the specific volume number 
rather than the total number of volumes in the set is included in the bibliography entry. 
 Multivolume works can be difficult. If your book is different from these examples, 
consult your advisor. 
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One Author, Different Titles 
 

F  22Hubert Hefner, The Nature of Drama, vol. 2, An Introduction to Literature, ed. Gordon 
N. Ray (Boston: Houghton Mifflin, 1959), 47-49. 
 

S  23Hefner, Nature of Drama, 48. 
 

B Hefner, Hubert. The Nature of Drama. Vol. 2, An Introduction to Literature, ed. Gordon N. Ray. 
Boston: Houghton Mifflin, 1959. 

If publishing dates are different for each volume, inclusive publishing dates for the set are given.  
 

F  24Nigel Turner, Syntax, vol. 3 of A Grammar of New Testament Greek, by James Hope 
Moulton, Wilbert Francis Howard, and Nigel Turner (Edinburgh: T. & T. Clark, 1908-1976), 38. 
 

B Moulton, James Hope, Wilbert Francis Howard, and Nigel Turner. A Grammar of New Testament 
Greek. 4 vols. Edinburgh: T. & T. Clark, 1908-1976.  

 
When the publisher and date are the same for all volumes of the set, facts of publication 

need not be repeated for each new volume cited. If there are differences, a complete entry must 
be given. Each volume title must have a bibliography entry, but only one bibliography entry is 
given for each example below. 
 

F  25Martin Luther, Luther’s Works (LW), vol. 51, Sermons 1, ed. and trans. John W. 
Doberstein (Philadelphia: Fortress, 1959), 259. 
 

S  26Luther, Sermons I, 260. 
 

N   27Martin Luther, LW, vol. 44, The Christian in Society 1, ed. James Atkinson, trans. W. A. 
Lambert, James Atkinson, and Charles M. Jacobs (Philadelphia: Fortress, 1966), 23.  
 

S  28Luther, The Christian, 30. 
 

B Luther, Martin. Luther’s Works. Vol. 51, Sermons 1. Edited and translated by John W. 
Doberstein. Philadelphia: Fortress, 1959. 

 
F  29Karl Barth, Church Dogmatics (CD), vol. III-3, The Doctrine of Creation, trans. G. W. 

Bromiley and R. J. Ehrlich (Edinburgh: T. & T. Clark, 1960), 82. 
 
S  30Barth, Doctrine of Creation, 85. 

 
N  31Karl Barth, CD, vol. I-2, The Doctrine of the Word of God, trans. G. T. Thomson and 

Harold Knight (1956), 69. 
 

B Barth, Karl. Church Dogmatics. Vol. III-3, The Doctrine of Creation. Translated by G. W. 
Bromiley and R. J. Ehrlich. Edinburgh: T. & T. Clark, 1960.  
 
This type of entry applies also to the following works: 
Aquinas, Thomas, Summa Theologica 
Carrington, Philip, The Early Christian Church 
Froom, Leroy E., The Prophetic Faith of Our Fathers 
Schaff, Philip, The Creeds of Christendom 
Sheldon, Henry C., History of the Christian Church 
Wesley, John, The Works of John Wesley 
 

  



 
 

62 

Periodicals 
 Distinction is made between magazines, which are periodicals for general consumption, 
and journals, which are academic and professional. 
 
Magazines 

F  32Melak Alemayehu, “Leave Not the House Empty: How to Ensure Revival and 
Reformation,” Ministry, December 2011, 10-12. 
 

B Alemayehu, Melak. “Leave Not the House Empty: How to Ensure Revival and Reformation.” 
Ministry, December 2011, 10-12. 

  
Journals 

F  33Ranko Stefanovic, “The ‘Lord’s Day’ of Revelation 1:10 in the Current Debate,” 
Andrews University Seminary Studies 49 (2011): 269. 
 

B Stefanovic,  Ranko. “The ‘Lord’s Day’ of Revelation 1:10 in the Current Debate.” Andrews 
University Seminary Studies 49 (2011): 261-284. 

 
While it is not indispensable to add the month or season, if the paging of a journal begins 

with 1 only at the beginning of a volume, you help your reader find a source by adding this 
information. The example would then read 49 (Autumn 2011). If the journal begins paging anew 
with each issue, the month or season is indispensable. If there is no season or month, give the 
issue number: Newsletter 4, no. 1 (1980): 9. 

Note that in footnotes and bibliographical entries for periodicals there is a space between 
the colon and the page number. This is different from books, where there is no space between 
volume number and page number. 

 
Book Review 

N  34Richard P. Taub, review of Reclaiming Public Housing: A Half-Century of Struggle in 
Three Public Neighborhoods, by Lawrence J. Vale, American Journal of Sociology 110, no. 3 
(November 2004): 797. 

 
 Book reviews are not included in the bibliography. 
  

Specialized Books 
Commentaries with Known Author 

Articles within the set are authored by different people and signed, either with initials or 
with a name. If only initials are given, the legend providing the full name of the author is 
generally found in the front of the volume.  
 

F  35G. Ernest Wright, “Exegesis of the Book of Deuteronomy,” Interpreter’s Bible (IB), ed. 
George Arthur Buttrick (New York: Abingdon, 1954), 2:331. 
 

S  36Wright, “Deuteronomy,” 2:332. 
 

N  37Martin Rist, “The Revelation of St. John the Divine,” IB, 12:346. 
 

B Wright, G. Ernest. “Exegesis of the Book of Deuteronomy.” Interpreter’s Bible. Edited by 
George Arthur Buttrick. New York: Abingdon, 1954. 2:331-540.  

 
This type of entry applies also to the following works: 
The Abingdon Bible Commentary 
Bible Knowledge Commentary 
The Biblical Illustrator 
The Broadman Bible Commentary 
The Eerdmans’ Bible Commentary 
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The Expositor’s Bible Commentary 
The Expositor’s Greek Testament  
The Evangelical Commentary on the Bible 
Harper’s Bible Commentary 
The International Bible Commentary With the New International Version 
The Interpreter’s One-Volume Commentary on the Bible 
The Jerome Biblical Commentary 
The New Bible Commentary  
A New Catholic Commentary on Holy Scripture 
The New Jerome Biblical Commentary 
Peake’s Commentary on the Bible 
The Pulpit Commentary 
The Speaker’s Bible 
The Wesleyan Bible Commentary 
 

Commentaries in a Numbered Series 
These commentaries have numbered volumes by different authors. Do not use the names of 

general editors. You may include the name of a translator or editor for the individual volume. 
 

F  38E. A. Speiser, Genesis, Anchor Bible (AB) 1 (Garden City, NY: Doubleday, 1987), 56. 
 

S  39Speiser, Genesis, 57. 
 
N  40Edward R. Campbell, Ruth, AB 7, 27. 

 
B Speiser, E. A. Genesis. Anchor Bible 1. Garden City, NY: Doubleday, 1987. 
 
B Campbell, Edward R. Ruth. Anchor Bible 7. Garden City, NY: Doubleday, 1975. 

 
This type of entry applies also to the following works: 
Black’s New Testament Commentaries 
The Century Bible 
A Commentary, Critical, Experimental and Practical on the Old and New Testaments 
The Communicator’s Commentary 
Good News Studies 
The Laymen’s Bible Commentary 
Living Word Commentary 
The New American Commentary 
New Testament Message 
Old Testament Message 
The Preacher’s Complete Homiletic Commentary 
Sacra Pagina 
Tyndale New Testament Commentaries 
Tyndale Old Testament Commentaries 
Word Biblical Commentary 

 
Commentaries in Unnumbered Series 

The difference with the above is that there are no numbers for the volumes. Each volume is 
separately titled and authored by a different person. 
 

F  41F. F. Bruce, The Book of the Acts, New International Commentary on the New Testament 
(NICNT) (Grand Rapids: Eerdmans, 1988), 65. 
 

S  42Bruce, Acts, 66. 
 

B Bruce, F. F. The Book of the Acts. New International Commentary on the New Testament. Grand 
Rapids: Eerdmans, 1988. 
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This type of entry applies also to the following works: 
Bible Study Commentary 
Biblical Commentary on the Old Testament  
Cambridge Bible Commentary 
Commentary on the Old Testament 
Daily Study Bible 
Everyman’s Bible Commentary 
Exegetical Commentary 
Harper’s New Testament Commentaries 
Hermeneia 
International Commentary on the Old Testament 
International Critical Commentary 
Interpretation 
Moffatt New Testament Commentary 
New Century Bible  
New International Commentary on the Old Testament 
New International Greek Testament Commentary 
New Testament Commentary (Hendriksen) 
Old Testament Library 
Torch Bible Commentary 
Westminster Commentary 
 

Commentaries with a Single Author 
The set will have a general title, and some sets will have separately titled volumes. When 

the entire set is by one person, both the set and the title of any single volume are italicized. 
If there are editors or translators for single volumes, they may be included after the title of 

the volume. 
 

F  43Matthew Henry, Matthew Henry’s Commentary on the Whole Bible, vol. 5, Matthew to 
John (New York: Fleming H. Revell, 1935), 73. 
 

B Henry, Matthew. Matthew Henry’s Commentary on the Whole Bible. Vol. 5, Matthew to John. 
New York: Fleming H. Revell, 1935.  

 
This type of entry applies also to the following works: 
Alford’s Greek Testament: An Exegetical and Critical Commentary (Alford) 
Calvin’s New Testament Commentaries (Calvin) 
Clarke’s Commentary on the Whole Bible (Clark) 
Commentary: Critical and Explanatory on the Whole Bible (Jamieson, Fausset, Brown)  
Expositions of the Holy Scripture (Maclaren) 
Gill’s Commentary (Gill) 
Interpretation (Lenski) 
Word Pictures in the New Testament (Robertson) 

 
Seventh-day Adventist Commentary 
 Authors’ names are not given for this commentary. 
 

F  44“Fourteenth Year” [Ezek 40:1], Seventh-day Adventist Bible Commentary (SDABC), rev. 
ed., ed. Francis D. Nichol (Washington, DC: Review & Herald, 1976-1980), 4:715. 
 

S  45“Fourteenth Year,” SDABC, 4:717. 
 

N  46“Were among Them” [Josh 10:1], SDABC, 2:223. 
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The first bibliographical entry is for the specific quotation; the second is for the whole of 
the work. If several references are made to different sections of the SDABC, a general entry may 
be used. 

 
BP “Fourteenth Year” [Ezek 40:1]. Seventh-day Adventist Bible Commentary. Rev. ed. Edited by 

Francis D. Nichol. Washington, DC: Review & Herald, 1976-1980. 4:715-717. 
 

BT Nichol, Francis, ed. Seventh-day Adventist Bible Commentary. Rev. ed. Washington, DC: 
Review & Herald, 1976-1980. 

 Comments from Ellen G. White that are quoted in the SDABC should be cited from their 
original source. 
 
Bible Dictionaries or Encyclopedias with Signed Articles  

The facts of publication are given for both footnote and bibliography entries. Each separate 
author entry must have a bibliography entry. The abbreviated title (see S below), while not 
required, adds clarity. 
 

F  47Ernst Jenni, “Day of the Lord,” The Interpreter’s Dictionary of the Bible (IDB), ed. 
George Arthur Buttrick (Nashville: Abingdon, 1962), 1:784. 
 

S  48Jenni, “Day of the Lord,” IDB, 1:785. 
  

N  49John Wick Bowman, “Revelation, Book of,” IDB, 4:62. 
 

B Jenni, Ernst. “Day of the Lord.” The Interpreter’s Dictionary of the Bible. Edited by George 
Arthur Buttrick. Nashville: Abingdon, 1962. 1:784-785. 

 
F  50Ulrich Becker, “Book,” New International Dictionary of New Testament Theology 

(NIDNTT), ed. Colin Brown (Grand Rapids: Zondervan, 1975), 1:242. 
 

S  51Becker, “Book,” NIDNTT, 1:243. 
 

N  52Hans-Georg Link, “Life,” NIDNTT, 2:475. 
 

B Becker, Ulrich. “Book.” New International Dictionary of New Testament Theology. Edited by 
Colin Brown. Grand Rapids: Zondervan, 1975. 1:242-243. 

 
F  53Rudolph Bultmann, “Aidōs,” Theological Dictionary of the New Testament (TDNT), ed. 

Gerhard Kittel and Gerhard Friedrich, trans. Geoffrey W. Bromiley (Grand Rapids: Eerdmans, 
1964-1976), 1:169. 
 

S  54Bultmann, “Aidōs,” TDNT, 1:170. 
 
N  55Otto Schmitz, “Thronos,” TDNT, 3:161. 

 
B Bultmann, Rudolph. “Aidōs.” Theological Dictionary of the New Testament. Edited by Gerhard 

Kittel and Gerhard Friedrich. Translated by Geoffrey W. Bromiley. Grand Rapids: 
Eerdmans, 1964-1976. 1:169-171. 

 

Note: The abbreviation “ed.” is never written in plural as it stands for “edited by.”  
 
This type of entry applies also to the following works: 
The Anchor Bible Dictionary  
Concise Dictionary of Christian Ethics 
Concise Dictionary of the Christian World Mission 
Dictionary of the Apostolic Church  
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A Dictionary of the Bible (Smith) 
Dictionary of the Bible (Hastings) 
Dictionary of Biblical Theology  
A Dictionary of Christian Antiquities 
A Dictionary of Christian Biography 
A Dictionary of Christian Theology 
Dictionary of Christianity in America 
A Dictionary of Pastoral Care 
Dictionary of Pastoral Care and Counseling 
Evangelical Dictionary of Theology 
Exegetical Dictionary of the New Testament 
An Expository Dictionary of New Testament Words 
Harper’s Bible Dictionary 
Holman Bible Dictionary 
The Illustrated Bible Dictionary 
The New Bible Dictionary 
A New Dictionary of Christian Ethics 
A New Dictionary of Christian Theology 
New Dictionary of Theology  
The New Dictionary of Theology 
The New International Dictionary of the Bible 
The New International Dictionary of the Christian Church  
New Unger’s Bible Dictionary 
The Oxford Companion to the Bible 
Theological Dictionary of the Old Testament 
Theological Wordbook of the Old Testament 
The Westminster Dictionary of Christian Ethics 
Westminster Theological Wordbook of the Bible 
 

Encyclopedias with Signed Articles 
General encyclopedias, such as the Britannica or Americana require only the date; general 

encyclopedias are included only in the notes. Specialized encyclopedias require full publication 
information. 
 

F  56Frank A. Spina, “Rahab,” The International Standard Bible Encyclopedia (ISBE), 
completely rev. and reset ed. (Grand Rapids: Eerdmans, 1979-1988), 4:33.  
 

S  57Spina, “Rahab,” ISBE, 4:34. 
 

N  58Howard F. Vos, “Kaiwan,” ISBE, 3:2. 
 

S  59Vos, “Kaiwan,” ISBE, 3:3.  

B Spina, Frank A. “Rahab.” The International Standard Bible Encyclopedia. Completely rev. and 
reset ed. Grand Rapids: Eerdmans, 1979-1988. 4:33-34. 

B Vos, Howard F. “Kaiwan.” The International Standard Bible Encyclopedia. Completely rev. and 
reset ed. Grand Rapids: Eerdmans, 1979-1988. 3:2-3. 
 
This type of entry is used also for the following works: 
Baker Encyclopedia of the Bible 
Encyclopaedia Judaica 
Encyclopedia of Early Christianity 
The Encyclopedia of Religion 
Encyclopaedia of Religion and Ethics 
Encyclopedia of Theology 
New Catholic Encyclopedia 
New 20th-Century Encyclopedia of Religious Knowledge  
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The Zondervan Pictorial Encyclopedia of the Bible 
Bible Dictionaries or Encyclopedias with Unsigned Entries 

The footnote entry includes author or editor (if any), title, edition/date, s.v. “Entry.” No 
place and publisher appear in the footnote, but this information appears in the bibliography. If 
several entries are used, the bibliography may be general. 
 

F  60Siegfried H. Horn, Seventh-day Adventist Bible Dictionary (SDABD), rev. ed. (1979), 
s.v. “Angel.” 
 

S  61Horn, SDABD, s.v. “Angel.” 
 

N  62Horn, SDABD, s.v. “Moses.” 
 

B Horn, Siegfried H. Seventh-day Adventist Bible Dictionary. Rev. ed. Washington, DC: Review & 
Herald, 1979.  

 
F  63Allen C. Myers, ed., Eerdmans Bible Dictionary (EBD) (1987), s.v. “Hyssop.”  

 
N  64Myers, EBD, s.v. “Psalm.” 

 
B Myers, Allen C., ed. Eerdmans Bible Dictionary. Grand Rapids: Eerdmans, 1987.  

 
This type of entry applies also to the following works: 
Dictionary of the Bible (McKenzie) 
Dictionary of the New Testament 
An Expository Dictionary of Biblical Words 
Nelson’s Illustrated Bible Dictionary 
The Oxford Universal Dictionary 
The Oxford Dictionary of the Christian Church 
The New Westminster Dictionary of the Bible 

 
Language Dictionaries 

Editors are not given for general language dictionaries. Footnote entry includes title, 
edition/date, s.v. “Entry” (s.v. is Latin for “see under”). Publishing information is not given in 
footnotes for general dictionaries. Language dictionaries do not appear in the bibliography. 
Either of the forms given here is acceptable, but only one can be used in the same paper. 
 

F  65Merriam-Webster’s Collegiate Dictionary, 10th ed., 1993, s.v. “Laity.” 
 

F  66Merriam-Webster’s Collegiate Dictionary, 10th ed. (1993), s.v. “Clergy.”  
 

F  67Webster’s Third New International Dictionary of the English Language Unabridged 
(1993), s.v. “Theodicy.” 
 

N  68Webster’s Third New Unabridged, s.v. “Apocalypse.” 
 

This type of entry applies also to the following works: 
The Random House Dictionary of the English Language  
Webster’s New Geographical Dictionary 
Webster’s Eleventh New Collegiate Dictionary 
 

Greek and Hebrew Lexicons 
 This type of reference work follows the same pattern as unsigned dictionaries, but may 
include editors and translators of new editions. Because these are often not commonly known 
materials, they must appear in the bibliography; however, the words looked up are not usually 
listed. 
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F  69Walter Bauer, A Greek-English Lexicon of the New Testament and Other Early Christian 
Literature (BAGD),3 trans. and adapted by William F. Arndt and F. Wilbur Gingrich, 2nd ed., 
rev. and augmented by F. Wilbur Gingrich and Frederick W. Danker (1979), s.v. “kosmeō.” 
 

S  70Bauer, BAGD, s.v. “kosmeō.” 
 
N  71Bauer, BAGD, s.v. “stauros.” 

 
B Bauer, Walter. A Greek-English Lexicon of the New Testament and Other Early Christian 

Literature. Translated and adapted by William F. Arndt and F. Wilbur Gingrich. 2nd ed. 
Revised and augmented by F. Wilbur Gingrich and Frederick W. Danker. Chicago: 
University of Chicago Press, 1979.4   

 
F  72Francis Brown, with S. R. Driver and Charles A. Briggs, A Hebrew and English Lexicon 

of the Old Testament With an Appendix Containing the Biblical Aramaic (BDB), based on the 
lexicon of William Gesenius (1952), s.v. “raq.” 
 

S  73Brown, BDB, s.v. “raq.” 
 

N  74Brown, BDB, s.v. “melek.” 
 

B Brown, Francis, with S. R. Driver and Charles A. Briggs. A Hebrew and English Lexicon of the 
Old Testament with an Appendix Containing the Biblical Aramaic. Based on the lexicon of 
William Gesenius. Oxford: Clarendon, 1952.  

 
This type of entry is used also for the following works: 
The Analytical Greek Lexicon (Bagster, Moulton)  
A Concise Hebrew and Aramaic Lexicon of the Old Testament (Holladay)  
A Greek-English Lexicon (Liddell, Scott) 
Greek-English Lexicon of the New Testament (Thayer) 
Greek-English Lexicon of the New Testament Based on Semantic Domains (Louw, Nida) 
A Manual Greek Lexicon of the New Testament (Abbott-Smith) 
The New Analytical Greek Lexicon (Pershbacher) 

 
Concordances 
 Concordances follow the same pattern as unsigned dictionaries and lexicons. 
 

F  75Robert Young, Analytical Concordance to the Bible, 22nd American ed., s.v. “prince.” 
 
S  76Young, Analytical Concordance, s.v. “prince.” 

 
N  77Young, Analytical Concordance, s.v. “kingdom.” 

 
B Young, Robert. Analytical Concordance to the Bible. 22nd American ed. Grand Rapids: 

Eerdmans, n.d.  
 

This type of entry applies also to the following works: 
Analytical Concordance of the Greek New Testament (Clapp, Friberg, Friberg) 
A Concordance to the Greek New Testament (Moulton, Geden) 
Cruden’s Unabridged Concordance (Cruden) 

                                                 
 

 
3 BAGD and BDB are not italicized here because they do not represent the title of the books, but 

rather, stand for the editors of the book. 
 
4 When you use more than one item, there is no need to list each entry separately in the 

bibliography. Put s.v. when using only one item, otherwise omit.  
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The Exhaustive Concordance of the Bible (Strong) 
A New Concordance of the Bible (Even-Shoshan) 

Encyclopedias with Unsigned Articles 
Publishing information is not included in footnotes. One bibliographical entry is adequate. 

 
F  78Seventh-day Adventist Encyclopedia (SDAE), rev. ed., (1996), s.v. “Pitcairn.” 

 
S  79SDAE, s.v. “Pitcairn.” 

 
N  80SDAE, s.v. “Battle Creek.” 

 
B Seventh-day Adventist Encyclopedia. Rev. ed. Washington, DC: Review & Herald, 1996. 

 
This type of entry may also be used for articles in the following works: 
Encyclopedia Americana 
Encyclopaedia Britannica 
Encyclopedia of Judaism 
World Book Encyclopedia  

 
Early Christian, Classical, and Medieval Works 

Editors and facts of publication may be omitted in the footnote. In the footnote, there is no 
punctuation between the name of the author and the name of the work. There is no difference 
between first and second footnote. A bibliography entry is given for each new title. For examples 
of Jewish/Rabbinic literature, see Vyhmeister, Quality Research Papers. 
 

F  81Irenaeus Against Heresies 2.2.3 (ANF, 1.421, trans. Roberts and Rambaut). 
 

S  82Irenaeus Against Heresies 2.2.3 (ANF, 1.421). 
 

B Irenaeus. Against Heresies. Translated by Alexander Roberts and W. H. Rambaut. The Ante-
Nicene Fathers. Grand Rapids: Eerdmans, n.d. 1:315-567. 

 
F  83John Chrysostom The Priesthood 3.17, Migne Patrologia Graeca, vol. 48, col. 656. 

 
S  84Chrysostom The Priesthood 3.18. 
 
B Chrysostom, John. The Priesthood, Patrologia Graeca. Edited by Jean Paul Migne. Paris: Apud 

Garnier Fratres, 1862. Vol. 48, cols. 623-692. 
 
F  85Josephus Jewish War 2.7.2 (trans. Thackeray, LCL, 2:363).  
 
S  86Josephus Jewish War 2.7.2. 

 
B Josephus, Flavius. The Works of Josephus. Edited by William Whiston. 4 vols. New York: 

Oakley Mason, 1860. 
 

F  87Eusebius Ecclesiastical History 5.2 (trans. Cruse, 182). 
 

B Eusebius. The Ecclesiastical History of Eusebius Pamphilus. Translated by Christian Frederick 
Cruse. Grand Rapids: Baker, 1987. 

 
Adventist Materials 

 These examples refer to the paper versions of these materials. Today, these resources will 
usually be cited from online sources (see the bibliographic entry for the Church Manual for an 
example of citing the online source. Also see the section on electronic sources). The URL for 
most Adventist materials is http://ast.gc.adventist.org. When you use these materials from an 
online source, be sure to give the URL and the date accessed. 
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SDA Church Manual 
F  88General Conference of Seventh-day Adventists, Seventh-day Adventist Church Manual 

(Silver Spring, MD: General Conference of Seventh-day Adventists, 1990), 23. 
 

S  89Church Manual (1990), 57.  
 

B General Conference of Seventh-day Adventists. Seventh-day Adventist Church Manual. Silver 
Spring, MD: General Conference of Seventh-day Adventists, 1990, accessed January 24, 
2010. http://www.adventistarchives.org/docs/CM/CM1990_B.pdf#view=fit_. 

 
Minister’s Manual 

F  90General Conference of Seventh-day Adventists, Ministerial Association, Seventh-day 
Adventist Minister’s Manual (Silver Spring, MD: General Conference of Seventh-day 
Adventists, 1992), 48. 
 

S  91Minister’s Manual, 85. 
 

B General Conference of Seventh-day Adventists, Ministerial Association. Seventh-day Adventist 
Minister’s Manual. Silver Spring, MD: General Conference of Seventh-day Adventists, 
1992. 

 
SDA Yearbook 

F  92General Conference of Seventh-day Adventists, Office of Archives and Statistics, 
Seventh-day Adventist Yearbook 1995 (SDA Yearbook 1995) (Silver Spring, MD: General 
Conference of Seventh-day Adventists, 1995), 75. 
 

S  93SDA Yearbook 1995, 64. 
 

B General Conference of Seventh-day Adventists, Office of Archives and Statistics. Seventh-day 
Adventist Yearbook 1995. Silver Spring, MD: General Conference of Seventh-day 
Adventists, 1995. 

 
GC Working Policy 
 If more than one edition of the Working Policy is cited, the second note will add the year. 
 

F  94General Conference of Seventh-day Adventists, Working Policy of the General 
Conference of Seventh-day Adventists, 1992-1993 ed. (Hagerstown, MD: Review & Herald, 
1993), 136. 

 
S  95Working Policy (1992-1993), 148. 
 
B General Conference of Seventh-day Adventists. Working Policy of the General Conference of 

Seventh-day Adventists. 1992-1993 ed. Hagerstown, MD: Review & Herald, 1993. 
 
Seventh-day Adventist Hymnal 

F  96The Seventh-day Adventist Hymnal (SDA Hymnal) (Washington, DC: Review & Herald, 
1987), 213. 
 

S  97SDA Hymnal, 100. 
 

B The Seventh-day Adventist Hymnal. Washington, DC: Review & Herald, 1987. 
 
Statistical Reports 

F  98General Conference of Seventh-day Adventists, Office of Archives and Statistics, 
Annual Statistical Reports (Silver Spring, MD: General Conference of Seventh-day Adventists, 
1992), 16. 
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B General Conference of Seventh-day Adventists, Office of Archives and Statistics. Annual 
Statistical Reports. Silver Spring, MD: General Conference of Seventh-day Adventists, 
1992. 

 

Unpublished Academic Sources  
Dissertations and Theses 
  The first model is for a thesis or dissertation available from the university where it was 
written. The second is for a dissertation published as a book. The third is from an online source. 
To cite a dissertation consulted online, include the access date and the URL. If the document was 
accessed in a library or online database, you may give the name of the database instead of the 
URL. 

F  99Dickens Miko, “A Strategy to Educate Seventh-day Adventists Cultivating Tobacco In 
Ndiwa Seventh-day Adventist Church In Kenya” (MA thesis, Adventist University of Africa, 
Nairobi, Kenya, 2013), 25.  
 

B Miko, Dickens. “A Strategy to Educate Seventh-day Adventists Cultivating Tobacco In Ndiwa 
Seventh-day Adventist Church In Kenya.” MA thesis, Adventist University of Africa, 
Nairobi, Kenya, 2013.  

 
F  100Brempong Owusu-Antwi, An Investigation of the Chronology of Daniel 9, Adventist 

Theological Society Dissertation Series 2 (Berrien Springs, Michigan: Adventist Theological 
Society, 1995), 37. 

 
B Owusu-Antwi, Brempong. An Investigation of the Chronology of Daniel 9. Adventist 

Theological Society Dissertation Series 2. Berrien Springs, Michigan: Adventist 
Theological Society, 1995. 

 
F           101Antonio Pantalone, “An Appraisal of the Development of Seventh-day Adventist 

Mission in South Africa: A Missiological Evaluation,” MTh thesis, University of KwaZulu-
Natal, 2012, in Research Space: A Digital Library for UKZN Scholarly Research, accessed 4 
September 2013, http://hdl.handle.net/10413/6511  
 

B     Pantalone, Antonio. “An Appraisal of the Development of Seventh-day Adventist Mission in 
South Africa: A Missiological Evaluation,” MTh thesis, University of KwaZulu-Natal, 
2012. In Research Space: A Digital Library for UKZN Scholarly Research. Accessed 4 
September 2013. http://hdl.handle.net/10413/6511. 

 
Syllabi, Course Outlines, or Class Handouts 

F  102Nancy Vyhmeister, Syllabus for MSSN 525 Mission to the World, SETAI Extension at 
Adventist University of Colombia, 2009, 2. 
 

B Vyhmeister, Nancy. Syllabus for MSSN 525 Mission to the World. SETAI Extension at 
Adventist University of Colombia, 2009. 

 
Student Class Notes 
 In referencing class notes, put the professor’s name and the class and school information. 

F  103Barry Bennett, class notes for OTST 653 Old Testament History, Adventist University 
of Africa, Nairobi, Kenya, January 2013. 
 

B Bennett, Barry. Class notes for OTST 653 Old Testament History. Adventist University of 
Africa, Nairobi, Kenya, January 2013. 

Miscellaneous Unpublished Sources 
Interviews 

If the interview has been done by the author, put that in the note: “interview by the author.” 
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Interviews appear in the bibliography only when the one who peruses the bibliography needs to 
know about this important source. 
 

F  104Laurent Kasay, Professor of New Testament, Lukanga Adventist University, interview 
by the author, Nairobi, 15 July 2011.  

 
B Kasay, Laurent, Professor of New Testament, Lukanga Adventist University. Interview by the 

author,  Nairobi, 15 July 2011. 
 
Reports and Minutes 

F  105Eastern Africa Division of Seventh-day Adventists, “Minutes of the East Africa 
Division Publishing Council,” (Harare, Zimbabwe: Eastern Africa Division, 24-31 October 
1986), 5. 
 

B Eastern Africa Division of Seventh-day Adventists. “Minutes of the East Africa Division 
Publishing Council.” Harare, Zimbabwe: Eastern Africa Division, 24-31 October 1986. 

 
Letters and E-mail 
 Personal letters and e-mail appear in the notes but not in the bibliography, unless it is vital 
that a person who checks the bibliography be aware of them. 
 

F  106John Henry, personal communication to the author, March 23, 2009. 
 
Letters in archival collections go in both notes and bibliography. 
 

F  107Ellen G. White to Dr. Patience Bordeau, 8 June 1905, Letter 177, 1905, Ellen G. White 
Research Center, Andrews University (EGWRC-AU), Berrien Springs, MI. 
 

S  108White to Bordeau, Letter 177, 1905. 
 
B White, Ellen G., to Dr. Patience Bordeau, 8 June 1905. Letter 177, 1905. Ellen G. White  

Research Center, Andrews University, Berrien Springs, MI. 
 

Manuscripts 
F  109Ellen G. White, “Our Opportunity to Work in the Cities of America,” Manuscript 154, 

1902, Ellen G. White Research Center, Adventist International Institute of Advanced Studies 
(EGWRC-AIIAS),5 Silang, Cavite, Philippines. 
 

S  110White, MS 154, 1902. 
 

B White, Ellen G. “Our Opportunity to Work in the Cities of America.” Manuscript 154, 1902. 
Ellen G. White Research Center, Adventist International Institute of Advanced Studies, Silang, 
Cavite, Philippines. 

 
Electronic Media 

 Never use a hyphen at the end of the line when a URL does not fit on one line. Divide a 
URL before a punctuation mark (use shift + enter to begin a new line but not a new paragraph), 
never within a word or number element.  
  
 Because websites are notoriously unstable and may disappear without leaving a trace, you 

                                                 
 

5 The school name is not required here, but it is helpful. If additional information is available and 
could be helpful, it is appropriate to include it. 
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need to give an access date. Thus, you protect yourself from your readers’ accusation of being 
careless in recording the URL if they cannot find your source. If the source gives a Digital Object 
Identifier (DOI), you may give it in place of a URL. 

 

 CD-ROM 
N  111Ellen G. White, Education, Complete Published Ellen G. White Writings [CD ROM] 

(Silver Spring, MD: Ellen G. White Estate, 1999). 
 

B White, Ellen G. Education. Complete Published Ellen G. White Writings [CD ROM]. Silver 
Spring, MD: Ellen G. White Estate, 1999. 

 
 Video 
N  112Hudson Taylor, 85 min., Ken Anderson Films, 1989, videocassette. 
 
B Hudson Taylor. 85 min. Ken Anderson Films, 1989. Videocassette. 
 

Article from a Library Database 
 If you used a pdf version of an article, you are not required to include online information. 
For other versions, include name or the home page of the search engine, or a direct link to the 
article. 
 

N  113 Daniel Howden, “Polio at Mecca Sparks Fear for Muslim Thousands,” Independent,  
12 February 2005, accessed June 3, 2010, http://www.lexisnexis.com/. 
 

B Howden, Daniel. “Polio at Mecca Sparks Fear for Muslim Thousands,” Independent,  
12 February 2005. Accessed June 3, 2010. http://www.lexisnexis.com/. 

General Internet Sources 
N  114 H. B. Moss and L. Kirisci, “Aggressivity in Adolescent Alcohol Abusers,” accessed 28 

January 2013, http://www.ncbi.nlm.nih.gov/pubmed/7573787. 
 

B Moss, H. B. and L. Kirisci. “Aggressivity in Adolescent Alcohol Abusers.” Accessed 28 January  
2013. http://www.ncbi.nlm.nih.gov/pubmed/7573787. 

 
Journal Accessed Online 

N  115Daniel A. McFarland, “Resistance as a Social Drama: A Study of Change-oriented 
Encounters,” American Journal of Sociology 109 (May 2004): 1249, accessed 3 May 2006, 
http://www.journals.uchicago.edu/AJA/journal/issues/v109n6/050199/050199.html. 

 
B McFarland, Daniel. “Resistance as a Social Drama: A Study of Change-oriented Encounters.” 

American Journal of Sociology 109 (May 2004): 1249-1318. Accessed 3 May 2006. 
http://www.journals.uchicago.edu/AJA/journal/issues/v109n6/050199/050199.html.  

 
 This article was available from JSTOR, through Andrews University. The same article, 
accessed through a different library, may have a different URL. 
 

N  116Shelly Whitman, “Women and Peace-building in the Democratic Republic of Congo: An 
Assessment of Their Role in the Inter-Congolese Dialogue,” African Journal on Conflict 
Resolution 6 (2006): 31, accessed 28 March 2010, http://www.accord.org.za/downloads/ajcr/ajcr 
_2006_1.pdf. 

B  Whitman, Shelly. “Women and Peace-building in the Democratic Republic of Congo: An 
Assessment of Their Role in the Inter-Congolese Dialogue.” African Journal on Conflict 
Resolution 6 (2006): 29-48. Accessed 28 March 2010. http://www.accord.org.za 
/downloads/ajcr/ajcr_2006_1.pdf. 

 
N   117Michael Jay Chan, “Cyrus, Yhwh’s Bird of Prey (Isa. 46.11): Echoes of an Ancient Near 
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Eastern Metaphor,” Journal for the Study of the Old Testament 35, no. 1 (September 2010): 
113–127, accessed 11 September 2011, http://dx.doi.org/10.1177/0309089210365963. 

 
B Chan, Michael Jay. “Cyrus, Yhwh’s Bird of Prey (Isa. 46.11): Echoes of an Ancient Near Eastern 

Metaphor.” Journal for the Study of the Old Testament 35, no. 1 (September 2010): 113–
127. Accessed 11 September 2011. http://dx.doi.org/10.1177/0309089210365963. 

 
 Book Accessed Online 
N  118Philip Schaff, Augustine’s City of God and Christian Doctrine (New York: Christian 

Literature Publishing, 1890), chapter 3, accessed 28 March 2010, http://ccel.org/ccel/schaff 
/npnf102.iv.ii.v.html. 

 
B Schaff, Philip. Augustine’s City of God and Christian Doctrine. New York: Christian Literature 

Publishing, 1890. Accessed 28 March 2010. http://ccel.org/ccel/schaff/npnf102.iv.ii.v 
.html. 

 
Conference Paper 
N  119Nilton Amorim, “Academic Freedom in Theology Teaching” paper presented at the Faith 

and Learning Seminar, Nairobi, Kenya, 1990, accessed 28 March 2010, http://www.aiias.edu/ict 
/vol_05/05cc_237-255.htm. 

  
B  Amorim, Nilton. “Academic Freedom in Theology Teaching.” Paper presented at the Faith and 

Learning Seminar, Nairobi, Kenya, 1990. Accessed 28 March 2010. http://www.aiias.edu 
/ict/vol_05 /05cc_237-255.htm. 

 
Thesis or Dissertation 
N   120Priscilla Coit Murphy, “What a Book Can Do: Silent Spring and Media-Borne Public  
 Debate,” (PhD diss., University of North Carolina, 2000), 121–125, accessed 1 April 2006, 

ProQuest Dissertations and Theses. 
 
B  Murphy, Priscilla Coit. “What a Book Can Do: Silent Spring and Media-Borne Public Debate.” 

PhD diss., University of North Carolina, 2000. Accessed 1 April 2006. ProQuest 
Dissertations and Theses.  

 
Online Dictionary or Encyclopedia 

These do not need to show in the bibliography. 
 
N  121Oxford English Dictionary, 3rd ed., s.v. “mondegreen,” accessed 1 February 2012, 

http://www.oed.com/view/Entry/251801. 
 
N  122Encyclopaedia Britannica, s.v. “Sibelius, Jean,” accessed 13 April 2011, http://www 

.britannica.com/EBchecked/topic/542563/Jean-Sibelius. 
 

N   123 “Barak Obama,” Wikipedia, accessed 22 September 2010, http://www.en.wikipedia.org.  
  

B  “Barak Obama.” Wikipedia. Accessed 22 September 2010. http://www.en.wikipedia.org. 
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Chapter 7   

An Introduction to APA Style 
 
 The School of Postgraduate Studies at AUA uses APA style for their research. This 
includes term papers and class assignments, theses and dissertations. If you plan to write a major 
paper using APA style, consider The Publication Manual of the American Psychological 
Association (Washington, DC: American Psychological Association, 6th ed.) an essential tool. 
There are also many useful web sites, a selected list of which is given at the end of this chapter. 

A brief introduction to APA referencing is shown here; however, students using this style 
should consider purchasing a manual of their own to be apprised of all the details. The AUA style 
requirements in Chapter 5 supersede the APA manual in matters of document format; in all other 
matters, the APA manual is the final authority. 
 

In-Text Referencing 
 Any idea that is not original to yourself should carry a reference in your paper. The 
referencing rules vary slightly depending on whether you have quoted someone’s words or 
merely referred to their ideas. 
 

How to Use Direct Quotations 

 Capitalization. Direct quotations may be part of the grammar of the sentence, or not. If 
they are, the beginning of the quote is not capitalized, even though it might be in the original 
work.  
 

Smith (1985) did not describe the child's behavior, but he did state that “the 
entry of the child into the strange environment caused disturbed behavior”  
(p. 123). 

 

He stated, “The entry of the boy into the strange environment caused the 
disturbed behavior” (Smith, 1985, p. 123), but he did not describe the behavior. 

 
 Page number information. If you use a direct quote, you must include the page number. 
The author’s name and date may appear in various positions, but the page number is placed at the 
end of the quote, after the quotation marks but before the period. 

The results of the experiment (Smith, 1985) showed that “the entry of the 
child into the strange environment cause disturbed behavior” (p. 123). 
 

Note: If a quote includes two or more pages, use a double p before the page number (pp. 45-46). 
 
 Block quotations.  A direct quotation of 40 words or more must be formatted as a block 
quotation, indented one tab position (it remains double-spaced). Punctuation after the 
introductory statement is optional—it depends on what introduction is used.  
 

Smith (1985) stated: 
 

After the child made some friends and identified with the adult in charge, the disturbed 
behavior decreased. The time factor required for this “settling in” process varied from child 
to child, depending on the age of the child, the general atmosphere of the new 
environment, and the temperaments of both the child and the adult involved. (p. 124) 

 

Note: In block quotations (unlike in-text quotations), the final punctuation follows the material 
quoted, and is followed by the reference, without any final period.  
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How to Paraphrase a Quotation 
 A paraphrase does not utilize the original grammar of the sentence. The page number (or 
paragraph number, for electronic sources) is not required for paraphrases, however, it is helpful 
to include this information if you have it.  

 

In his study, Smith (1985) observed that when the child entered the strange 
environment, disturbed behavior resulted (p. 123). 

  
Introducing Citations or Quotations 

There are many ways to cite in text, but the ideal forms use sentence space to discuss and 
analyze the quote or the citation, not to indicate who said it (the reference already does that). 

 a) An alternative interpretation that Smith (1985) suggests is to . . . 
 b) The results of one experiment (Smith, 1985) showed that “. . .” (pp. 73-75). 

     c) Coffee drinking has been found to affect . . . (Day, 2005, p. 280). 
not best d) As Day (2005) says, “. . .” 

If you occasionally wish to discuss the author, or wish to emphasize something about the 
individual, sentences like those below would be appropriate.  

 

e) In 1985, Smith studied . . . 
f) Smith (1985), who is an expert in the field of nutrition, found . . . (p. 74). 
g) Smith (1985, chap. 5) gives a summary . . . 

 
Specific In-Text Referencing Rules 
 

1. If information is given in the sentence, it is not repeated in the parentheses. See example 
a) above. 

2. The name and date can go with the page or earlier. See examples b) and c) above. 
3. If the name is used in text, the date usually follows it. See examples f) and g) above. 
4. The period or other punctuation marks are placed after the final parenthesis or at the end 

of the sentence. 
5. When the authors Smith and Johnson appear in the text, the word and is written out. 

When the names appear in parentheses, an ampersand (&) is used (Smith & Johnson).  
6. What is inside the parentheses is NOT considered part of the grammar of the sentence. 

For that reason, one cannot say “As (Smith & Johnson, 2009) suggest. . . .” Rather, say 
“As Smith and Johnson (2009) suggest . . . .” 

7. If you did not read the source, you cannot place it in the parentheses (for details, see the 
section on secondary sources under In-Text Referencing Examples below). 

 
Repeated References to an Author Within a Paragraph 

 

1. APA requires that the name and date reappear with each new paragraph.  
2. A study or an author may be mentioned again within the same paragraph without 

repeating the name, as long as it is clear to the reader which study is indicated.  
3. If the name is used a second time within the paragraph, however, the year should 

accompany it, for clarity.  
4. If the author’s name was placed within parentheses the first time, as in examples b) and 

c) above, it cannot appear as “he” or “she” thereafter, since the parentheses are not part 
of your sentence. 
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In-Text Referencing Examples 
 

One Author 
The required information is the author’s surname and the year of the publication. 

a) An alternative interpretation (Smith, 2007) suggests that . . . 
b) Grisso (2009) takes the idea a bit further when she . . . 

 
Multiple Authors  

Two authors. Include both authors every time you mention them. 
Three to five authors. Include all authors the first time you cite them. For subsequent 

citations use the surname of the first author and “et al.” 
 

  First citation  
a) One study (Smith, Johnson, & Brown, 2007) found . . . 
b) Smith, Johnson, and Brown (2007) found . . . 

 

 Subsequent citations 
c) Another study (Smith et al., 2007) found that . . . 
d) Smith et al. (2007) found that . . . 
e) Smith and others (2007) found that . . . 

 
 Six or more authors. Use the first author's surname and “et al.” the first and any 
subsequent times the source is used.  
 

    Recent research (Brown et al., 2008) indicated . . .  
 
Several Works in the Same Reference 
 When more than one source is given in parentheses, the authors' names are listed in 
alphabetical order. Note that all the studies were read by the researcher. Even if a source lists 
several references, you may only list the one(s) you read—you may not simply copy a list of 
references taken from someone else’s study.  
 

Same author. 
Several studies (Smith, 1977, 1982, 1983) show . . . 

 

Different authors. 
Recent studies (Brown, 1999; Johnson & Smith, 2008; Morrison, 2004; Smith & 
Ogleby, 2009) indicate that . . . 

 
One Author in the Same Year 

a) Smith (1984a) has pointed out that . . . 
b) Several studies (Brown, 2010; Smith, 2007a, 2007b) indicate that . . . 

 
 No Author 
 When no author is listed, it may be that an organization authored the piece (see Corporate 
Author, below). If there is no author listed, use the title, or at least the first few words of it, in the 
author position. If it is a book, periodical, or report, italicize it. If it is a journal article, title of a 
web page, or a chapter in a book, put it in quotes. 

a) Current information (Education Handbook, 2007) suggests that . . . 
b) Recent studies in this area (“Six Studies on Learning,” 2008) seem to show that . . . 
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Corporate Author 
 When citing government agencies, corporations, study groups or associations, use the full 
name every time it is mentioned in the text (see example a, below). You may abbreviate the name 
for the second and subsequent citations if the abbreviation is familiar, if it has been explained in 
the text and will be used at least 3 times (see example b, below), or if the complete name is very 
long. 
 

a) Statistics released (National Institutes of Mental Health, 1986) seem to show . . . 
b) A statistical analysis by the National Institutes of Mental Health (NIMH,1986) . . .  
 

In the reference list this would be spelled out as National Institutes of Mental Health. If you have 
five or more abbreviations in your paper, it is appropriate to make a list of abbreviations at the 
beginning. Once an abbreviation is explained, it should be used consistently throughout the 
paper. 
 
Authors With the Same Surname 

If two or more references have authors with the same surname, use the initials or, if 
necessary, the complete name of each author in all citations to avoid confusion. 

a) K. Lee (2008) suggests that Koreans were trying a different approach . . . 
b) Other research (see for example J. Lee, 2007) has found . . .  

 
Personal Communication 

This form is used for letters, e-mails, or conversations, with the author. Such references do 
not appear in the reference list. Give the initials with the surname and the complete date. 
 

L. R. Brown (personal communication, October 20, 2009) said that . . . 
 
Secondary Source 
 Always indicate the source where you read a citation. If you read certain information in 
someone else’s paper, you must indicate it properly as a secondary source. Citing secondary 
sources is generally frowned upon, but it is acceptable for supporting works that are difficult to 
find. Always try to find the original sources whenever possible. Note that the original source is 
mentioned first, and then the source where you read the citation, after “as cited in.”  

a) Brown (as cited in Smith, 2007) stated that. . . 
b) A recent study (Johnson,  as cited in Smith, 2007) points out. . . 

Note: In the reference list, only the source where you found the material is listed. 
 

Reprinted or Republished Works 
The first date is that of the original publication and the second is the date it was 

republished, reprinted, or published in the translated form. This information is especially useful if 
the study is following a historical sequence. 

 

a) Early research on Cerebral Palsy, (Freud, 1933/1974), pointed out that . . . 
b) The aim of true education is . . . (White, 1903/1952). 

 
Electronic Media 

Often no page numbers are provided with electronic sources. In that case, use paragraph 
numbers (preceded by “para.” or “¶”) to direct the reader to quoted material. Give the nearest 
document heading, and then count the paragraphs after that heading. Note that the web address 
(URL) does not go in the in-text reference. It goes in the reference list.  

a) As Rittenhouse (2001, para. 3) aptly phrased it, “There is no need . . .”  
b) “It is clear from conditions today that . . .” (Jacobs, 2003, Conclusion section, ¶ 1). 
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Reference List Basics 
 

The APA Publication Manual requires a reference list at the end of the paper, where each 
source actually cited in the paper must be included in the alphabetical list. No extra works are 
allowed. However, APA advises that some committees may require evidence that students are 
familiar with a broader spectrum of literature. If sources other than those actually cited in the 
paper are included, the reference list would be titled “Bibliography.” 
 
General Rules for Reference Lists 

1. Reference lists should appear as one alphabetical list. 
2. Run-over lines in references are indented by the regular default of .5”. 
3.  Entries are single spaced (the APA manual shows double spacing for those preparing a 

journal for publication). Since you are preparing a document in final form, single 
spacing, which looks nicer and saves space is used. Double space between entries. 

4. One entry should not be split across two pages. 
5. When an author has several works, each entry must provide the author's name (APA 

does not use an eight-space line or Ibid.). 
6. Several references by one author are arranged by year of publication, the earliest 

first—not alphabetically by title. References by the same author with the same 
publication date are arranged alphabetically by title and assigned lowercase letters—a, 
b, c (for more detailed examples, see References How-To below). 

 Smith, B. J. (2000a). Specific concerns . . . 
 Smith, B. J. (2000b). Trying to overcome . . . 

7. Italics—not underlining—is used for titles of books/journals.  
8. For the publisher’s name, use a “shortened” form (Sage; Jossey-Bass; Macmillan). Do 

not include “Publishing Company,” “Inc.,” or “Ltd.” However, the word “Press” is 
often retained, such as in Pacific Press. This always applies to university presses. 

9. No quotation marks are used for article titles in magazines/journals. 
10. For books, give the city and state (or city and country, if outside the U.S.) of 

publication, followed by the publisher. Use the state abbreviations (see p. 87) with no 
periods. APA 6 requires the city and the state/country for ALL reference entries: 

Reading, MA: Addison-Wesley. 
Mumbai, India: Peace Press. 
New York, NY: McGraw Hill.  

 Note: When New York is spelled out, it is the city.  
11. Titles of books are presented in sentence case. Proper nouns and the first word after a 

colon are capitalized: 
   From program to practice: A guide to beginning your new career. 
12. Journal titles are presented in title case. The title and the volume number are italicized. 

An issue number (if available) follows the volume number (no space), within 
parentheses (but not in italics). This is followed by the page numbers where the article 
was found: 

Ali, W. H. (2004). Learning teams and low achievers. Social Education, 48, 60-
64. 

Astin, A. W. (2007). Change. Competition Journal, 19(5), 12-19. 
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 Author Rules 
 

 Single author entries. Single author entries precede multiple-author entries: 
 

  Alleyne, R. L. (2001). 
  Alleyne, R. L., & Evans, A. J. (1999). 
 
      Same authors, different year of publication. Identical author entries are arranged by year 
of          
 publication, the earliest first: 
 

  Cabading, J. R., & Wright, K. (2000). 
  Cabading, J. R., & Wright, K. (2001). 
 
      Same authors, same year of publication. Identical author entries with the same publication  
 date are arranged alphabetically by the title. Lower case letters (a, b, c) are placed 

immediately after the year within the parentheses: 
 

  Baheti, J. R. (2001a). Control . . . 
  Baheti, J. R. (2001b). Roles of . . . 
 

Different subsequent authors. These are arranged alphabetically by the surname of the 
second author, or third author (if the second author is the same), and so on: 

  Gosling, J. R., Jerald, K., & Belfar, S. F. (2000). 
  Gosling, J. R., & Tevlin, D. F. (1996). 
 

  Hayward, D., Firsching, A., & Brown, J. (1999). 
  Hayward, D., Firsching, A., & Smigel, J. (1999). 
   

Different authors with the same surname. Arrange alphabetically by the first initial. 
 

  Mathur, A. L., & Wallston, J. (2009). 
  Mathur, S. E., & Ahlers, R. J. (1998). 
 
How to Reference Electronic Media 

The variety of material available via the Internet can present challenges for referencing 
because information is frequently missing. Internet sources should provide the same information 
as any other reference, if it is available, and a URL address. The retrieval date is no longer 
generally required. Specific suggestions include: 

1. Direct your reader as closely as possible to the information being cited—rather than the 
home page or menu pages. 

2. Test the URLs in your reference list before the final submission of the document. If the 
URL does not work, your reader will not be able to access the material you cited. Always 
retain copies of downloaded material until your paper is approved. 

3. Do not put a period after a URL.  
4. Break a long URL before punctuation. Use shift + enter to move the text to a new line.  
5. When there is a high possibility of change (personal websites, wikis, blogs, online 

discussions) the retrieval date should be included.  
Juke, A. (n.d.). My opinion about homework. Retrieved January 13, 2010 from 

http://www.myopinion.com 
6. Remove the underlining and blue color from URLs before you submit your paper. 
7. A DOI is a Digital Object Identifier, which is the most useful information to provide for 

online sources. If the DOI is provided, there is no need to give a URL for online journals. 
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Printed Materials  
One Author 
 Sommer, R. F. (1989). Teaching writing to adults. San Francisco, CA: Jossey-Bass. 
 
Up to Seven Authors 

Bennett, N., Crawford, M., & Cartwright, M. (2003). Effective educational leadership. 
London, UK: Open University Press.  

 
More Than Seven Authors 

Picton, T. W., Benton, S., Berg, P., Donchin, E., Hillyard, S. A., Johnson, R. J., . . . Taylor, 
M. J. (2000). Recording standards and publications criteria. Springfield, MA: 
Erlbaum. 

 
Author as Publisher 

American Psychiatric Association. (1990). Diagnostic and statistical manual of mental 
disorders (3rd ed.). Washington, DC: Author. 

 

 National Science Foundation. (2010). Earth sciences: Instrumentation and  facilities.  
Arlington, VA: Author.  

 
Edition  Other Than the First 

Denis, T., White, N., & Peterfreund, S. (2005). Great traditions in ethics (11th ed.). 
Belmont, CA: Wadsworth/Thomson Learning. 

 
Edited Book (Editor as Author)  
 Roth, J. (Ed.). (1995). International encyclopaedia of ethics. London, UK: Fitzroy 
Dearborn. 
 
Chapter in an Edited Book  

Anderson, P. (1985). What survey research tells us about writing at work. In L. Odell & D. 
Goswami (Eds.), Writing in nonacademic settings (pp. 239-252). New York, NY: 
Guilford. 

 
Translation 

Piaget, J. (1980). Six psychological studies. (A. Tenzer, Trans.). Brighton, UK: Harvester. 
(Original work published 1964). 

 
Book in a Foreign Language 

Kleinert, U., & Kühn, R. (2011). Und Sie zogen aus in Ein wüstes Land: Auf den Spuren 
der Bibel Durch den Sinai. [And they went out into a barren land: On the trail of the 
Bible through the Sinai]. Darmstadt, Germany: Wissenverbindet. 
 

Book Review   
 Rah, S. (2010, April). Heroic tales from distant lands [Review of the book Kingdom 

without borders, by M. Adeney]. Christianity Today, 54, 4. 
 
Article in a Magazine   

Adams, W. (2010, May 10). Norway builds the world’s most humane prison.  Time, 175, 
78. 

 
Article in a Newspaper 
 Gardiner, B. (2010, April 15).  Emphasis on ethics. The Wall Street Journal, p. 9. 

 
Article in a Journal  

 Knatterud, M. E. (1991). Writing with the patient in mind: Don’t add insult to injury. 
American Medical Writers Association Journal, 6, 10-17. 
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Electronic Sources 
Entire Book Online 

Boud, D., & Feletti, G. (Eds.). (1999). The challenge of problem-based learning (2nd ed.). 
Retrieved from http://books.google.com/books 

 
Article With DOI 
 Articles retrieved from an electronic database are now cited exactly as the print version 
unless the article is particularly difficult to find. No need to include date retrieved or the 
database. The DOI is included, when present, however, whether you read the print or the 
electronic version. 
 

 Devlin, J. T. & Poldrack, R. A. (2007). In  praise of tedious anatomy. NeuroImage, 37, 
1033-1041. doi:10.1016/j.neuroimage.2006.09.055 

 
Internet Article or Website (Without DOI) 

Lumsden, L. (1994). Student motivation to learn. Retrieved from http://chiron.valdosta 
.edu/whuitt/files/stdtmotv.html 

 
Article in an Internet-Only Journal  

Salend, S. J. (2004). Fostering inclusive values in children: What families can do. Teaching 
Exceptional Children, 37(1), 64-69. Retrieved from http://journals.sped.org 
/index.action=TEC_toc&ID=55 

 
Paper Presented at a Conference 
 Woll, C. (2006). The difficult organization of business interests. Paper presented at the 

15th International Conference of the Council for European Studies, Chicago, 
March 29-April 2, 2006. Retrieved from http://www.ces.columbia.edu/pub/papers 
/Woll.pdf 

 
Paper in Conference Proceedings 

Thompson, H. L. (2005). The impact of stress on the BarOn Eq-i reported scores and a 
proposed model of inquiry. In Proceedings of the 5th Annual NexusEq Emotional 
In-telligence Conference. Retrieved from http://nexuseq.com/post/dick_thompson2 
.pdf 

 
Newspaper Article (Online) 

Kershaw, A. (2010, May 05). Students hit by lecturers’ strike. The Independent. Retrieved 
from http://www.independent.co.uk   

 
Website of Organization or Governmental Agency 

British Educational Communications and Technology Agency. (2010). Assistive technology 
and the Home Access programme. Retrieved from http://schools.becta.org.uk/index 
.php?section=oe&catcode=ss_es_hom_02&rid=17557 

 

U.S. Copyright Office. (1981). Circular R1: Copyright basics (Publication No. 341-
279/106).  Washington, DC: Government Printing Office. 

 

Article in a Wiki  
School violence. (2010, May 13). In Wikipedia, the free encyclopedia. Retrieved May 20, 

2010, from http://en.wikipedia.org/wiki/School_violence 
 
Thesis Retrieved Online 

Havens, L. (2009).  Behavioral and socioeconomic differences among users of the internet 
public library from North Carolina. (Master’s thesis). Retrieved from http://www 
.openthesis.org/documents/Behavioral-Socioeconomic-Differences-among-Users 
-594471.html 
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Unpublished Material 
Unpublished Paper 

Skinner, E., & Belmont, M. (1991). A longitudinal study of motivation in school: 
Reciprocal effects of teacher behavior and student engagement. Unpublished 
manuscript, University of Rochester, NY, USA. 

 
Thesis/Dissertation  

Akpa, V.O. (2006). Factors that motivate employees to work at Northern Luzon Adventist 
College (NLAC), Philippines: An analysis (Unpublished master’s thesis). 
Adventist International Institute of Advanced Studies, Silang, Philippines. 

 
 

Missing Information   
No Date  
 Bligh, B. (n.d.). Cherish the earth. Sydney, Australia: Macmillan. 
 
No Author  
 Handbook of research. (1998). Princeton, NJ: College Board Publications. 
   
 

Additional Resources 
 

 Additional examples of reference list entries may be found in the American Psychological 
Association’s Publication Manual, 6th ed., or in online materials showing how to reference in 
APA style. Some useful APA sites are 
 
APA  
 http://www.apastyle.org/index.aspx 
 
Dalhousie University Libraries: APA Style (6th) Quick Guide 
 http://www.library.dal.ca/Files/How_do_I/pdf/apa_style6.pdf 
 
Northern Michigan University: APA Reference Style Guide  
 http://library.nmu.edu/guides/userguides/style_apa.htm 
 
The Owl at Purdue: Online Writing Lab 
 http://owl.english.purdue.edu/owl/section/2/10/ 
 
Queens University: Guide to Citing Education Resources in APA Format 6th Edition 
 http://library.queensu.ca/webedu/howtofind/apa.pdf 
 
Trinity University: APA Style for Electronic Sources 
 http://lib.trinity.edu/research/citing/APAelectronicsources.pdf 
 
 
  

http://www.apastyle.org/index.aspx
http://www.library.dal.ca/Files/How_do_I/pdf/apa_style6.pdf
http://library.nmu.edu/guides/userguides/style_apa.htm
http://owl.english.purdue.edu/owl/section/2/10/
http://library.queensu.ca/webedu/howtofind/apa.pdf
http://lib.trinity.edu/research/citing/APAelectronicsources.pdf
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APPENDIX A 
EDITING CHECKLIST 

This form is designed to help students (or advisors) review their paper before sending it to the 
AUA Editor. The Editor’s job is to CHECK for these things, NOT TO DO THEM FOR THE 
STUDENT. Attention to these details before your work is sent for editing will ensure much more 
rapid progress. 

MISCELLANEOUS FORMAT ITEMS 

_____ Document is in ONE file, and preliminary pages are properly numbered. 
_____ Page numbers are in the same font and size as the rest of the text.  
_____ Table of Contents is formatted with tabs and dot leaders, not spaces and full stops. 
_____ Table of Contents entries are title case, and page numbering corresponds to the actual titles. 
_____ Format for footnote marker in text: sentence punctuation, quote mark, footnote marker (.”3). 
_____ Abbreviations are used for books of the Bible in parentheses, and footnotes; they are written 

out if they are part of the sentence. 
_____ Round numbers or numbers below 10 are written out in words. 
_____ Dashes are formed by two hyphens—they have no space before or after them. 

SPACING 

_____ Preliminary pages have headers at 2” (5 cm) and follow the format illustrated in this book. 
_____ Document is left-justified, and double-spaced, with no extra space between paragraphs.  
_____ Single spacing is used for long quotes (Turabian), bibliography, and often for tables. 
_____ One blank line between chapter number/title, two blank lines between chapter title/text. 
_____ Two blank lines before and one blank line after subheadings within the text. 

TABLES/FIGURES 

 _____ Tables are readable, consistent in format, and have no vertical lines and few horizontal lines.  
 _____ Tables/figures are mentioned by name/number before appearing in text. 
 _____ Tables/figures are numbered consecutively (but separately) throughout the document.  
 _____ Table numbers and titles are typed above the table, figure numbers and titles, below.   
 _____ Three blank lines before and after tables/figures inserted within the text.  

_____ Tables are preferably at the top or bottom of a page, not in the middle.  
_____ If a table/figure is taken from another source, the complete source is cited below the table. 

HEADINGS and SUBHEADINGS 

_____ Headings and subheadings are properly chosen and formatted (subheadings are truly a 
division of the heading they fall under). 

_____ No heading has only a single subheading under it. 
_____ Capitalization of headings follows AUA style. 
_____ Spacing above and below headings is consistent and correct (2 blank lines above, 1 below). 
_____ No heading appears without at least two lines of text below it at the bottom of a page. 

FOOTNOTES and BIBLIOGRAPHY 

_____ Footnotes begin on the page (below text, not at the bottom of page) where citation is made. 
_____ Footnotes do not continue onto a second page unless they are more than ½ page long. Move 

a line or two of text to the next page if needed to achieve this. 
_____ Footnotes are indented the same as the paragraph and end with a full stop. 
_____ Individual footnotes are single spaced with double space between footnotes. 
_____ Footnotes are continuously numbered throughout each chapter. 
_____ Footnotes contain all required elements of each reference, including city and state/country, 

press, date, and page number. 
_____ Footnotes are carefully checked for punctuation, italics, proper spacing, capitalization, 

parentheses, spelling, and consistency. 
_____ All footnote references are ALSO included in the Bibliography.  
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APPENDIX B 
CAPITALIZATION RULES FOR THEOLOGICAL TERMS 

 

Names of the Trinity   Case 
the Trinity, Deity, Triune God, God, Father, Creator, Jehovah, the Source Upper 
Jesus, Christ, Son, Savior, Lord, Son of God, Lamb of God, the Word, Messiah,  
Prince of Peace 
Heir, High Priest (but as a high priest, an heir) 
Son of Man, King of Kings, Lord of Lords (as an eschatological title) 
Son of man, King of kings, Lord of lords (for general theological discourse) 

Upper  
 
Mixed 
Upper 
Mixed  

Holy Spirit, Comforter, Spirit, Paraclete Upper 
Derivatives of the Trinity 

kingship, sonship, heirship, messiahship, fatherhood, divinity, theology, messianic, 
christological, divine 

lower 

Christlike, Christian, Christology Upper 
Personal Pronouns for God 

He, Him OR he, him  
(The traditional way is to capitalize, but today’s English Bibles do not capitalize the pronouns.  
Follow your advisor’s preference, but be consistent throughout the paper.) 

Upper 
OR  
Lower  

People of the Bible and Early Christian Era 
the apostles/disciples, the patriarchs, the prophets, the apostle Paul, the prophet Daniel lower 
the Church Fathers, the Fathers, the Twelve, the Seventy Upper 
Gentile, Jew, Jewish  Upper 

Creeds 
the Apostles’ Creed, the Augsburg Confession, Luther’s Ninety-five Theses Upper 

Names for Scripture and Parts of Scripture 
Bible, Scripture(s), Septuagint (LXX), Masoretic Text (MT)  Upper 
God’s Word, Word of God (an unqualified name for Scripture)  
God’s word, word of God (general theological discourse) 

Upper 
lower 

biblical, scriptural, a psalm lower  
Old Testament (OT), New Testament (NT) Upper 
all books of the Bible (Exodus, Matthew) Upper 
the Pentateuch, the Prophets, the Writings (as part of the Hebrew Bible) Upper 
the Psalms, the Shepherd Psalm, the Gospels, the Fourth Gospel, the Synoptics Upper 
the Epistles (referring to a specific collection), the Apocalypse (referring to 
Revelation) 
the Pauline Corpus, the Epistle to the Hebrews, the Epistle of Jude 

Upper  
 
Upper 

the epistles of Paul (for general discourse) lower 
the Decalogue, the Ten Commandments, the Ten Words, the Lord’s Prayer Upper 
the parables, the parable of the lost coin (for general discourse) lower  
the Parable of the Prodigal Son (when used as a title),  
the Sermon of the Mount, the Olivet Discourse  

Upper 

the Great Commission (unqualified) 
the great commission of Christ to his disciples (general) 

Upper  
lower  

Bible Doctrines for General Reference (examples) 
the millennium, the sanctuary, the state of the dead, the mark of the beast,  
the second coming of Christ, holy communion 

lower  

the investigative judgment, the seal of God, the law of God,  
the nature of Christ, the Christian life  

Mixed 
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The Church  Case 
the church (general discourse about the Christian church)  
the church (referring to any church body, but not by name) 
the Church (as a concept [rarely used]) 

lower  
lower 
Upper 

the apostolic church (designating a particular era) 
the New Testament church (designating a particular era) 

lower  
lower 

Denominations  
 the Lutheran Church, the Seventh-day Adventist Church   

 
Upper 

Churches by Location 
 the Atlanta church (not official name) 
 the European church (not official name) 

 
lower 
lower  

Official Names of Churches 
 the Clear Lake Seventh-day Adventist Church (official name) 
 Maxwell Academy SDA Church (Official name, SDA abbreviated)    

 
Upper 
Upper 

Church Offices/Officers 
the deacon/deaconess, the elder/elders  
the district leader, the church pastor, the ministerial director 
the East-Central African Division, Kenya Union Conference, Rwanda Union Mission 
Pastor Kavuga, Elder Chungwe, the Kanama District 
the division president, the conference treasurer 

lower  
lower 
Upper 
Upper 
lower 

Bible Events and Times 
Special, unique events, when unqualified appear in capitals. When qualified, they 
appear in lowercase. 

 

the Creation (unqualified) 
the creation of the world (qualified)  

Upper  
lower  

the Incarnation (unqualified) 
the incarnation of Christ (qualified)  

Upper 
lower 

the Atonement (unqualified) 
the atonement for mankind (qualified)  

Upper 
lower  

the Crucifixion (unqualified) 
the crucifixion of Christ (qualified) 

Upper 
lower  

the Resurrection (unqualified) 
the resurrection of Christ (qualified) 

Upper 
lower 

the Exodus (unqualified) 
the exodus of Israel from Egypt (qualified) 

Upper 
lower  

the Flood, the Deluge (unqualified) 
the flood of Noah (qualified)  

Upper 
lower  

the Second Advent, the Second Coming (unqualified) 
the Parousia (unqualified) 
the second coming of Christ (qualified)   

Upper 
Upper 
lower  

Theological Terms  Case 
the plan of salvation, the plan of redemption lower 
the Gospel (unqualified; as a concept—rarely) 
the gospel of Christ, the gospel of grace (qualified)  

Upper  
lower  

the Third Angel’s Message (as a title) 
the third angel’s message (general), the three angels’ messages (general) 

Upper 
lower 

the Sabbath (seventh day of the week) 
the ceremonial sabbaths (Mosaic) 

Upper 
lower 

the Spirit of Prophecy (collected writings of E. G. White) 
the spirit of prophecy (Rev 19:10)  

Upper  
lower  
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APPENDIX C 
SOME USEFUL ABBREVIATIONS 

 
 
State Abbreviations for the United States 
 In footnotes and reference lists/bibliographies, the names of the states in the United States 
are always abbreviated. Table C1 contains the two-letter abbreviations for each state. 
  
Table C1. United States Two-Letter State Abbreviations 
Location Abbreviation Location Abbreviation Location Abbreviation 
Alabama    AL Kentucky KY North Dakota ND 
Alaska    AK Louisiana LA Ohio OH 
Arizona AZ Maine ME Oklahoma OK 
Arkansas AR Maryland MD Oregon OR 
California CA Massachusetts MA Pennsylvania PA 
Colorado CO Michigan MI Rhode Island RI 
Connecticut CT Minnesota MN South Carolina SC 
Delaware DE Mississippi MS South Dakota SD 
District of Columbia DC Missouri MO Tennessee TN 
Florida FL Montana MT Texas TX 
Georgia GA Nebraska NE Utah UT 
Hawaii HI Nevada NV Vermont VT 
Idaho ID New Hampshire NH Virginia VA 
Illinois IL New Jersey NJ Washington WA 
Indiana IN New Mexico NM West Virginia WV 
Iowa IA New York NY Wisconsin WI 
Kansas KS North Carolina NC Wyoming WY 

 
 
Biblical Book Abbreviations 
 Both the Seminary and the School of Postgraduate Studies should use the biblical book 
abbreviations found in Table C2. They are written with no periods. Abbreviations are used when 
specific chapter or chapter-and-verse references are given, not when the Bible book name alone 
is used. Do not use these abbreviations to begin a sentence, or within a title. 

 
Table C2. Biblical Book Abbreviations 
Gen 1 Kgs Eccl Obad Matt Phil 1 Pet 
Exod 2 Kgs Song Jonah Mark Col 2 Pet 
Lev 1 Chr Isa Mic Luke 1 Thess 1 John 
Num 2 Chr Jer Nah John 2 Thess 2 John 
Deut Ezra Lam Hab Acts 1 Tim 3 John 
Josh Neh Ezek Zeph Rom 2 Tim Jude 
Judg Esth Dan Hag 1 Cor Titus Rev 
Ruth Job Hos Zech 2 Cor Phlm  
1 Sam Ps (Pss) Joel Mal Gal Heb  
2 Sam Prov Amos  Eph Jas  
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APPENDIX D   
TIPS FOR MAKING STUDENT RESEARCH PUBLISHABLE 

 
 A publishable paper is different in several ways from the typical class paper. Usually it contains 
primary data, or presents new ideas. Before preparing a publishable article, decide which journal you will 
submit it to. Study the articles in that journal and the guidelines for authors which the journal provides. 
These instructions regarding content, format, and submission, must be followed exactly and in detail. 
 Publishers expect articles to be clear and succinct. An article will be shorter than the paper on 
which it is based. The basic parts, however, must appear. For a theological paper, the parts are as follows: 
1. Introduction (containing statement of problem, purpose, and procedure followed (where the research 
started, what kinds of sources were used, etc.). 2. A review of literature may or may not be needed. Often 
that information appears in the footnotes. 3. Analysis of the topic (this may be historical or topical). 4. 
Conclusion, where the author sets forth the "so-what" of the information presented. The parts of an 
empirical study are included in the explanation below, which has been prepared for empirical research, 
however, students preparing an article for a theological or ministerial journal will also find it helpful. 
 
 

Student paper Publishable paper How to get there 
Can tend to be wordy, 
unedited. 

Tight, no wasted words, highly polished. Write it, then edit it repeatedly using other 
readers if possible, until output is high quality. 

Can appear as if the student is 
trying to stretch the paper to 
meet the minimum length 
requirement. 

General feeling that the author has more 
to say than what will fit and is trying to 
reduce the paper to meet the maximum 
length allowed.  

Start with a slightly longer paper and reduce 
it. Often you need to begin with 30-35 pages 
and reduce to 25. 

Often lengthy general 
introduction. 

Introduction and Literature Review are 
usually combined and point to the need 
for the present study. 

Keep introduction short. Write a paragraph or 
two, and move directly into your study. The 
introduction must convince readers of the 
timely relevance of your study and show its 
place in current research.  

Literature Review is lengthy, 
contains a lot of general 
information, not many 
primary sources. Often does 
not give reasons for inclusion 
of information. 

Literature review is focused and relatively 
brief. It contains mainly primary studies 
closely related to the research, not 
general, introductory sources or 
tangentially related past work.  

Read the general introductory studies for your 
own information, if needed, but do not put 
them in the introduction. A dissertation 
contains a general literature review occupying 
a whole chapter which an article leaves out. 

Frequent use of poor quality 
sources, such as general 
internet articles on a topic, 
textbook explanations, 
Wikipedia definitions, etc. 

Sources must be recent, and closely 
related to the study. High quality sources, 
such as journals, recently published 
books, and primary studies are used. 
Review articles can be useful summaries 
or sources of expert opinion. Breadth is 
sought to include multiple perspectives.  

Seek out high quality sources, especially 
primary studies that are directly related to your 
study. Ask more from your sources. Mediocre 
sources make a mediocre paper. There is 
plenty out there—make the effort to find the 
good stuff. 

Tends to use a lot of 
quotations, even lengthy 
ones. 

Few quotations, but many references; 
often multiple ones in the same area 
reinforcing a point of view or line of 
research. 

Make sure you understand what is being said, 
and summarize/reduce bulky ideas into 
smaller spaces using the support of multiple 
sources. 

Tends to rely heavily on a few 
sources 

Much more breadth of sources; not overly 
dependent on a chosen few. 

Find out who are the key authors in a field and 
cite them, but seek breadth, as well as depth. 
One article per area discussed is not sufficient 
coverage. 

Analysis is heavily tied to 
ideas found in the literature. 
Little original thought is 
evident. 

Independent thinking is clearly 
demonstrated; ideas come from the author 
as well as the literature; value added by 
the author is clearly demonstrated. 

Read more. Think more. Do not write the first 
thing you see. When you have read more 
deeply and widely, you will begin to have your 
own expertise to write about. Be careful to 
link your own ideas to sources contributing to 
or sharing perspectives you develop. 
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Student paper Publishable paper How to get there 
Plagiarism is not always 
carefully avoided. Sometimes 
this is due to poor technique, 
sometimes because the 
student does not believe it is 
important. 

Plagiarism has no place here. Quotations 
and ideas of others are carefully 
referenced. 

This is an area which must be carefully 
guarded in all papers. Reference carefully at 
all times; take special care with internet sites 
to acknowledge authorship correctly. For help 
with electronic sites, see http://owl.english| 
.purdue.edu/owl/resource/560/10/ 

Personally created 
summaries, lists, tables or 
figures are rare; any found in 
the text are usually quoted. 

Appropriate summaries, figures, tables, or 
lists are generated when analysis requires 
some creative form of synthesis to 
describe what was learned. Figures from 
others are almost never reproduced. 

Seek opportunities to summarize combine, 
create, construct, and share ideas in the form 
of personally created tables, figures, or graphs. 
These are fine outputs for the analysis you 
should be doing. Resist the temptation to 
quote other people’s analyses in your paper—
just reference them. 

The referencing style is often 
followed mechanically, but 
not well understood. 

Evidence is given of clear understanding 
of the referencing style, be it APA 
(http://flash1r.apa.org/apastyle/basics 
/index.htm), Turabian (see http://www 
.docstyles.com/cmscrib.htm), or SBL. 

Follow carefully the style manual indicated by 
the journal in which you wish to publish. 
Thoroughly learn the reference style required. 
Have others who know it well check your 
paper. 

Headings are frequent, but 
not always meaningful. 

Headings are carefully planned to divide a 
piece into sections and subsections. 

Edit your headings specifically. Don’t overuse 
them. Consider the organization of your piece 
so that the headings help structure your article. 
Ask for expert opinions.  

Quotations are often 
introduced in a wordy way 
that does not show true 
analysis of what was said. 

Quotations are rare; ideas from sources 
are analyzed and compared with ideas 
from other sources. The referencing style 
shows source information, leaving the 
writer free to make analytical comments. 

Practice this. Make sure every word counts. 
Do not begin sentences with authors’ names 
but rather with ideas. Compare/contrast and 
synthesize relationship ideas adequately. 

Often repetitive, loosely 
organized. 

Tightly organized by topic, with each 
topic being addressed once—no 
repetition. 

Write an outline first; check the organization 
before you finish. Print the article and check 
its organization, making sure that all similar 
ideas are in the same place or are clearly 
associated by linking terms. Do not repeat 
yourself.  

Method section tends to cover 
several pages. 

Method is almost like a formula—it is 
concise, dense, and short--usually only a 
page or so. Much of the ethical and data 
collection details are left out and 
presumed to be cared for by the author. 

From the description of the methodology in 
your paper, create a more concise explanation, 
following the norms of the discipline. A 
dissertation will have much more detail in the 
method than an article. 

Analysis is often bulky and 
repetitive. 

Analysis is as concise as possible. Tables 
and text overlap very little, but rather, 
complement each other. Comments and 
references to relevant literature are made 
when appropriate. 

You may need to write out a bulkier data 
section at first and then reduce it. Do not 
repeat yourself or describe uninteresting data. 
Tell the important parts and say that the rest 
confirmed prior research, was insignificant, or 
contributed no new knowledge. 

Analysis tends to be driven 
by numbers which are 
sometimes not interpreted 
adequately and are often 
awkward to read. 

Analysis is written in as simple a 
language as possible, highlighting 
meaning, interpreting statistics to confirm 
trends or hypotheses and practical appli-
cations to the ideas of the research study. 

Editing is needed here. Early drafts look more 
like plain SPSS output. Later drafts will read 
more like a reasoned explanation or expository 
story, with numbers for support. 

Conclusion tends to repeat 
analysis, rather than bringing 
something new. 

Conclusion puts together all the pieces 
found in the analysis (without necessarily 
restating them) and analyzes the whole, 
bringing in references to literature, 
interested parties, etc. The conclusions are 
tied to the data, but clearly represent the 
author’s explanation of the meaning of 
the data. 

This requires careful writing, personal critical 
thinking, disciplined creativity in forming new 
syntheses suggested by the data and discussion 
with your advisor. Put your ideas in your 
writing; test them on your advisor. Write, and 
be prepared and willing to rewrite. Do not 
repeat here. Conclusions should be short, 
meaningful, and powerful. 

 

http://flash1r.apa.org/apastyle/basics%0b/index.htm
http://flash1r.apa.org/apastyle/basics%0b/index.htm
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